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A. Preface

Purpose

This document describes the functionality and procedures involved in using the EVE
Screen Designer (ESD).

Intended Audience

The intended audience shall be any GUI application developer working with EVE
products.

Document Reference

Document Name Document Type Document Format
FT81x Series Programmers Guide Programming Guide PDF
FT81x Datasheet Datasheet PDF
FT9xx Toolchain Installation Guide Installation Guide PDF
BT81X Series Programming Guide Programming Guide PDF
BT81X (815/6) Datasheet Datasheet PDF
BT817/8 Datasheet Datasheet PDF

Feedback

Every effort has been taken to ensure that the document is accurate and complete.
However, any feedback on the document may be emailed to docufeedback@brtchip.com.
For any additional technical support, refer to http://brtchip.com/contact-us/.
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B. Overview

Introduction

EVE Screen Designer (ESD) is the next generation of smart IDE for EVE, making EVE-
based GUI development much easier to accomplish. This tool enables users to build one
GUI application using a visual programming' method without needing to know any
EVE-specific display list commands.

ESD provides a WYSIWYG ("What You See Is What You Get”) environment for editing
graphics, designing visual effects, and defining GUI application user logic,
generating ANSI C code for the targeted hardware platform. Users can also choose to
simulate the whole design to experience the UI before compiling and downloading the
generated source code. Furthermore, ESD has the capability to work seamlessly with
Bridgetek FT9XX Toolchain. Users can compile, link the generated source code with
FT9XX Toolchain and upload it to the targeted platform without leaving ESD. From 4.13
onward, ESD has the same capability as FT90X platform to work with Raspberry Pi
Pico?.

A layout mechanism is introduced to manage widgets and pages in a more generic way.
The layout mechanism will enable users to create more dynamic UI much easier than
before. In addition, ESD 4.14 dramatically enhances the functionality of the logic nodes
editor, layout editor and project browser, for better user experience.

Key Features

The following are some of the key features of EVE Screen Designer:

WYSIWYG GUI

High level widgets

No EVE display list knowledge required

Widget based GUI construction

Drag and drop widget to create screen layout

Inter widget communication

Screen logic creation without coding

Simulation of screen logic and user touch input using mouse

Building and downloading the generated “C"” code (if FT9XX/Pico Toolchain is
installed)

FEEEEFFEE

What's new in ESD 4.18

New Features:

+ Removed irrelevant source codes from the HAL of exported ESD project.

+ Added the support of BT88x based module: IDM2040-43A.

+ Introduced a new feature in the ESD Textbox widget, enabling automatic fitting of
its text within the box.

1 https://en.wikipedia.org/wiki/Visual programming language
2 https://www.raspberrypi.org/products/raspberry-pi-pico/
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Implemented the ability to double-click to open example projects.

Added a configuration select the QSPI(Quad) mode or single SPI mode.

Replaced include file names "FT_" with "Ft" and "<FT" with "<Ft" in all the source
code.

Added the Icon Theme project to the Example projects.

Provided support for the Resource type PROGMEM option for image resources.
Added the Asset Browser project into the Example projects.

Improved the About window.

Fixed the error that occurred when opening the bitmap Persistence example
project in Windows Sandbox.

Removed unnecessary Qt debugging DLLs.

Corrected the problem of missing text in some logic editor nodes.

Fixed the bug where the Font Icon dialog would still appear after the app was
closed.

Resolved the issue that the Vertical Linear Roller Widget can't scroll.

Added Graph example project into Intermediate category of example projects.
Updated the version attribute to "41802" for all example projects.

Fixed the Image convert error with DXT1L2 and DXT1PALETTED format.

Hid the irrelevant options “*Memory Pool Limit” and “Pre-allocated Memory Pool”
when Memory Pool Allocator is set to FALSE.

Known Issues & Limitations

The following are some known issues and limitations of ESD:

e &+ FF+EFFEFF ++&

= Only the BT81X/FT81X series EVE is supported. FT80X Series EVE is NOT
supported.

* The C code editor in ESD does not support the following features:

Code completion

Column mode

Line bookmarking

Error and Warning Marks

Structure Visualizer

Word Wrap

Expand and collapse blocks of code.
Highlighting of multiple selected text portions

O 0O 0 O O O O O

= If the project file path is too long (i.e., more than 512 bytes), ESD may have a
problem opening it. The typical error message is shown below:

“Unable to generate output files, check directory permission at:
C:\Users\xxxx.xxxx\Project\ESD\...... ”

Where

“C:\Users\xxxx.xxxx\Project\ESD\...... » refers to the project folder.

= Logic node editor background goes white after system hibernates.
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= In some unusual cases, users may encounter a dialog box (shown below) which
will not affect the functionality. In this case, just ignore the dialog box by closing
it.

B i| EmulatorProcess.exe has stopped working

Windows can check online for & solution to the problem.

# Check online for a solution and close the program
* Close the program

2 Debug the program

v View problem details

= In few cases, users may need to click [Recompile] at the toolbar to update the
frozen simulation result.

» The Gameduino 3X dazzler platform does not currently support game controllers,
which means that users are unable to interact with ESD projects. Additionally, the
use of an SD card is necessary.

» Extended font is not supported in FT81X chips, but no error report will be
generated if choose it in ESD

» When utilizing the ESD Circular Gradient Slider, certain scenarios may cause lines
to appear on the Screen Layout Editor (Emulator), as depicted in Figure 1.
However, no lines are ever displayed on the hardware side, as illustrated in
Figure 2.

Figure 1 Screen Layout Editor

IDM2040-7A

Figure 2 Hardware IDM2040-7A
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Terms & Abbreviations

Terms/Abbreviations Description

Actor

DLL

ESD
EAB
EVE Emulator
HAL

IDE
Layout type widget

Logic Node
Logic Node Editor
Page

Simulation
Widget

Credits

One type of logic node which is regularly updated but without visual
appearance

Dynamic Link Library is a collection of small programs, any of which
can be called when needed by a larger program that is running in the
computer

EVE Screen Designer

EVE Asset Builder

Bridgetek behaviour-modelling software for EVE Series chip
Hardware Abstraction Layer is a software subsystem providing
hardware abstraction.

Integrated Development Environment

One type of widget which has no visual appearance rendered by EVE,
but manages the associated widget

The node expressing certain logic. (Also referred to simply as “node” in
this document)

The place where you create logic by connecting the logic node

One single screen in design

Preview the project or page by running the generated C code on PC
One type of logic node which has visual appearance rendered by EVE

Open-Source Software

Qt: https://doc.qt.io/gt-6/licensing.html under LGPL.

TinyCC: http://bellard.org/tcc/ and http://repo.or.cz/tinycc.git under LGPL.
Errorlist module: https://github.com/kaetemi/errorlist under MIT license

QScintilla: part of PyQt under PyQt commercial license

https://riverbankcomputing.com/commercial/license-fag

Icons Copyright

Some of the icons are from:
http://p.yusukekamiyamane.com/

They are used in compliance with the Creative Commons Attribution 3.0 License.
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C. Setup & Installation

System Requirements

To install ESD application, ensure that your system meets the requirements
recommended below:
v Ideally Windows 10; alternatively, Windows 8 or 7 with the latest windows
updates
1.6GHz or faster processor
1GB of RAM (1.5GB if running on a virtual machine)
Multi-Core CPU is highly recommended
At least 512MB hard disk space
Display resolution 1080x800 pixels or higher

2SR NN NN

“Write” permission to the installation folder

Hardware Requirements

The exported C source code from ESD is targeted at EVE based platform, which
typically consists of an Eve module and a host (MCU or PC based module).

The supported platforms are listed as below:

Build Target

[Eve Platform] [Host Platform]
MEB10A-HV35R
MEg12A-

e ™ et
VM316CUS04

VMB16C50A

GD3X Dazzler
D204
MES1TEV
VME10c =1 MPSSE

Emulator

VME16C
MEZ10A-HVI5R
MES1 2A-WHS

MEBTTEV

GameDuino 3X Dazzler for Pico

[DM2040

Product Page 10
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Platform Name
(Build Target)

Compatible EVE Module

Compatible MCU
Module Name

Compatible PC

based Module

ME810A-HV35R ME810A-HV35R5(320X480) MMSOOEY!
MES12A-WH50R ME812A-WH50R® (800x480) MM2040EV?2 N.A.
) ME812AU-WHS50R® (800x480) FT4222H°
ME812AU-WH50R N.A. (libFraas dll)
) ] ; MMOOOEV"
ME813A-WH50C MES13A-WH50CS (800x480) o2 A
8
MES813AU-WH50C  ME813AU-WH50CS (800x480) N.A. (Ii;r'?41222222Hdll)
; MPSSE
VM810C50A VM810C50AS (800x480) N.A. (libMPSSE. )
7
VM816C50A VM816C* (800x480) N.A. (“bmggg al
8
VM816CUS0A VM816CU* (800x480) N.A. (Ii;r'?4222222Hd||)
) ; FT4222H°
MES17EV-WH70C  MES17EVS (1024X600) MMOOOEV: (6490 dll)
2 8
MES17EV-WH10C  MES17EVS (1280X800) MM2040EV (|it'>_—f-£?4222222Hd||)
Gameduino 3X Gameduino 3X Dazzler (HDMI Raspberry Pi Pico’ N.A.
Dazzler for Pico output 1280x720) P Y
IDM2040-7A IDM2040-7A° (800x480) Raspberry Pi Pico? NA.
IDM2040-43A IDM2040-43A (480x272) Raspberry Pi Pico? N.A.
1. MM900EV development modules:
a. MMO00EVXxA - End of Life
b. MM900EVxXB - https://brtchip.com/product/mm900evib/
c. MM900EV-Lite - https://brtchip.com/product/mm900ev-lite/
2. MM2040EV is a Raspberry Pi Pico adaptor board:

https://brtchip.com/product/mm2040ev/

3. Raspberry Pi Pico is from: https://www.raspberrypi.com/products/raspberry-pi-pico/

4, VM816C is the EVE 3 development module: https://brtchip.com/wp-
content/uploads/Support/Documentation/Datasheets/ICs/EVE/DS VM816C.pdf

5. ME817EV is the EVE 4 development module:
cateqgory/products/modules/eve4/

https://brtchip.com/product-

6. The EVE 2 development modules: check https://brtchip.com/product-

category/products/modules/eve2/ for details

7. MPSSE stands for “multi-purpose synchronous serial engine”. The following
Bridgetek or FTDI devices support it:

a. VABO00A-SPI board
b. C232HM-EDHSL-0(5V) cable
c. C232HM-DDHSL-0(3.3V) cable

8. FT4222 refers to the bridge chip which converts from USB Hi-Speed
transportation to Multi-Channel Serial SPI protocol. See:
https://ftdichip.com/products/ft4222h/
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9. IDM2040 is an embedded application platform from Bridgetek which consists of:

a. RP 2040 as MCU: https://datasheets.raspberrypi.org/rp2040/rp2040-

datasheet.pdf
b. BT817 as GPU: BT817/8 Advanced Embedded Video Engine (brtchip.com)

10.Gameduino 3X Dazzler is an open-source project originally for Arduino:
https://www.crowdsupply.com/excamera/gameduino-3x-dazzler
ESD supports one variety — Gameduino 3X Dazzler for Pico, which consists of:

e Raspberry Pi Pico as MCU module
e BT815 as GPU

You can get more details from:
https://excamera.com/sphinx/store.html#gameduino-3x-dazzler-for-pico-39

To ensure proper functioning of the hardware platform (FT90X modules or

& Raspberry Pi Pico), users need to make sure that an SD card is inserted into the
SD slot. This is because ESD is programmed to identify the presence of an SD
card, and if it fails to do so, the application may not work correctly.

Dependencies / Pre-Requisites

e Visual C++ Redistributable for Visual Studio 2015

If the PC does not have Microsoft Visual Studio 2015 installed, Visual C++
Redistributable is required. Users can download this from:

https://www.microsoft.com/en-sg/download/details.aspx?id=48145

¢ Windows 10 Universe C Runtime

ESD has run-time dependency on Windows 10 Universe C Runtime (CRT). You may
download it from https://www.microsoft.com/en-us/download/details.aspx?id=48234
and install on your PC should the following problem be encountered:

ScreenDesigner.exe - System Error ﬂ
The prograrm can't start because api-ms-win-crt-runtime-11-1-0.d1 is
migging frem your computer. Try reinstalling the program to fic this

problem.

Figure 3 - Screen Designer - System Error

¢ FT9XX Tool Chain Version 2.4.0 or later

To compile and build projects, the FT9XX Tool Chain 2.4.0 or later version must be
installed on the PC. It is downloadable from https://brtchip.com/ft9xx-toolchain/ .
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Please ensure that the Tool Chain executable path is defined by the system PATH
environment variable.

Users are advised to check the known issues and limitations (of FT9XX Toolchain)
while building the ESD project with FT9XX Toolchain. The respective FT9XX Toolchain
package version release note contains the list of known issues and limitations.

For ESD, we recommend users to install FT9XX Tool Chain version 2.5.0 or later
version for the best results.

e Raspberry Pi Pico Tool Chain

To compile and build Pico projects, several tool chains must be installed on the PC.
They are: Pico-SDK, python 3.8, GNU Embedded Toolchain for Arm and Cmake. They
can be downloaded/cloned from the following:

=  Pico-SDK - https://github.com/raspberrypi/pico-sdk

= Python 3.8 - https://www.python.org/downloads/

= GNU Embedded Toolchain - https://developer.arm.com/downloads/-/gnu-rm

= CMake - https://cmake.org/download/

ESD will check System Eile Edit Build Tools Wiew Help

environment variables T T B GG

to find these tool bro t' Clean Unused Generated Files Ctrl+Shift+P

f . 'rojec

ChaInS, and it also Configure cross-compilation Environment Ctrl+Shift+C
provides a user dialog
to configure the tool
chain path under Tools RETS

menu: Browse

Configure cross-compilation Environment n

Browse

Browse

Installing ESD Package |

The following steps will guide you through the ESD Setup/Installation process.

i. Download the package from https://brtchip.com/esd/.

ﬁ! Setup - EVE Screen Designer - X

ii. When prompted with a download
dialog box. Click [Save].

Welcome to the EVE Screen
Designer Setup Wizard

This will install EVE Screen Designer version 4. 13RC1 on your
computer.

iii. Navigate to the folder under which the
package files are downloaded.

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup,

iv. Extract the zip file contents. Double
click on the executable file - EVE
Screen Designer.exe
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The EVE Screen Designer Setup Wizard is displayed along with a Welcome

message. Click [Next].

V. End User information window
is displayed. Click [Next].

vi. Select the “Destination
Folder” for installing the files.
Accept the default folder or
click Browse to select a
different destination folder. To
confirm the destination folder
and continue, click [Next].

In the Select Additional
Tasks window, check “Create
a desktop / Create Quick
Launch shortcut” boxes, to
have the ESD icon and Quick
Launch shortcut displayed on
the desktop if required.
Click [Next] to prepare for
the installation.

Vii.

The initial setup is completed,
and the application is ready to

ﬁl Setup - EVE Screen Designer — X

Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

',EUE Screen Designer 4.13 pre Release A

Featues:
WYSIWYG IDE
Logic node based Visual Programming method for screen logic creation
ANSI C Code generation for completed project
Live preview the designed project
Higher level widget and widget communication
Interactive widget
Extensible Widget Library
Tool Chain integration
Comprehensive example projects.

< Back Cancel

ﬁ%‘ Setup - EVE Screen Designer — X

Select Destination Location
Where should EVE Screen Designer be installed?

Setup will install EVE Screen Designer into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

||b|ic \Documents\EVE Screen Designer| Browse. ..

At least 327.6 MB of free disk space is required.

< Back Cancel

ﬁl Setup - EVE Screen Designer — X

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing EVE Screen
Designer, then dick Next.

Additional shortcuts:
Create a desktop shortcut
Create a Quick Launch shortcut

be installed.
< Back Cancel
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viii.

iX.

X.

Click [Install] to start the installation.

ﬁﬂ Setup - EVE Screen Designer

Ready to Install

change any settings.

Setup is now ready to begin installing EVE Screen Designer on your computer,

Click Install to continue with the installation, or dick Badk if you want to review or

Destination location:
C:\Users\Public\Documents\EVE Screen Designer

Additional tasks:
Additional shortcuts:
Create a desktop shortcut
Create a Quick Launch shortout

< Back ] Install ]

Cancel

The progress bar indicates that the installation is in progress.

ﬁl Setup - EVE Screen Designer

Installing
Please wait while Setup installs EVE Screen Designer on your computer.

Extracting files...
C:\Users\Public\Documents\EVE Screen Designer \Objectiidgets.dll

In the Information page, click [Next] to proceed ahead.

ﬁ! Setup - EVE Screen Designer

Information
Flease read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

Vredits :
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Xi. Upon successful installation, click [Finish].

5 Setup - EVE Screen Designer |£|_|—]

Completing the EVE Screen
Designer Setup Wizard

Setup has finished installing EVE Screen Designer on your
computer, The application may be launched by selecting the
installed shorteuts.

Click Finish to exit Setup.

Launch EVE Screen Designer!

(%

Installation Folder

The following table provides a list of folders that can be found under the installation
path:

Folder Name Description Permission

Examples The example projects created by ESD @ Read/Write

Imageformats Qt run-time DLLs for image format Read-Only
supporting

Styles Qt run-time DLLs for UI styles Read-Only

Libraries Widget library, application framework | Read-Only
and Hardware abstraction layer

Log Stores the runtime logs for debug Read/Write
purpose

Manual Contains this document Read-Only

Platforms Qt platform specific run-time DLLs Read-Only

Settings Configuration files for third-party Read-Only.
utilities and tool chains as well as ESD | Reserved for advanced
settings. users to change.
The files are in XML format.

Templates The template files used by ESD Read-Only

TinyCC TinyCC run-time used for ESD Read-Only
simulation purpose.

Tools The utilities used in ESD for bitmap Read-Only

and font data generation purpose
Table 1 - Installation Folder
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Users can refer to EVChargePoint examples in the path <ESD Folder>/Examples/
Advanced/EVChargePoint. Opening it may take more than 5 minutes because of ASTC,
bitmap and font conversion. This example contains all of the new BT81X features. Here

are the details:

1. Apply ASTC Bitmap Format for images and fonts.

VEITS

rces/Card.png

Bitmap

COMPRESSED_RGBA_A
False
False

Value
urce File Pre
lame Resource:
Font

EXTENDED_ASTC

Font Size

24
Figure 4 - ASTC applied for images and fonts

2. Resources are stored and loaded from flash.

Value

AnimationScreensaver.bin

SD_RESOURCE_DIRECTFLASH

£En.png
d.png
rge.png

VEIT
lesource File Pro:
ame Resources/BtnCharge.png
Narne Bitmap
Category
Format COMPRESSED_RGBA_ASTC_...
Cormpressed False
v True

0

Cell Names ]

Figure 5 - Load resources from flash
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3. Use Unicode font with ASTC format and predefined character set

Property
yurce File Pr
File Narme
Mame
Category

Format

Font Size
Character Set RE BT ElR% A mink) : FerR A+ jEl B

Figure 6 - Use Unicode font with pre-defined character set

THEH...
O
;*‘ N 7@ 250
2 %

/- Z

|

Figure 7 - Chinese font used in application

Support for ASTC bitmap format ‘

ESD provides the option to convert images to the ASTC bitmap format, resulting in
significant storage space savings without compromising image quality.
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Figure 8 - ASTC Format

Support DXT1 bitmap format \

DXT1 (also known as Block Compression 1 or BC1) is the smallest variation of S3TC,
storing 16 input pixels in 64 bits of output, consisting of two 16-bit RGB 5:6:5 color
values(c0,cl), and a 4x4 two-bit lookup table. ESD supports the following 3 varieties of
DXT1 format bitmap.

o DXT1: the 4x4 two-bit look up table is expressed in L1 format, while c0,c1 is
expressed in RGB565 format.

o DXT1L2: the 4x4 two-bit look up table is expressed in L2 format. while c0,c1
is expressed in RGB565 format.

o DXT1PALETTED: the 4x4 two-bit look up table is expressed in L2 format.
while (c0,c1) is expressed in PALETTED565 format.
By replacing the RGB565 layers with PALETTEDS65 layers, the size is further
reduced to 2 bytes per block total for the color layers, which results in a 3 bits
per pixel plus the color palette of up to 512 bytes.

Just as with other bitmap format, once the image is added into project, users can select
the "Format” property of input image and set it to the DXT1 related format. The example
project “BitmapFormats” shows the effect of DXT1 format bitmap, by comparing with
other bitmap formats which Eve supported.
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Project

Library

LETTED4444. png
LETTED565

rEr v Er T gy

e A
== App.main
Bl AppScreen.page

App.main

DXTT

DXT1L2

Figure 9 DXT1 format bitmap in BitmapFormats example project

Output Format for DXT1:

When the DXT1 format is selected in ESD, it is then converted to two file formats:
*_b0.raw and *_c0.raw, or alternatively, *_b0.bin and *_b0.bin (if the compressed flag
is selected).
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MewProject’® » Build » IDM2040-TA » Data w| Search Data
G Mame Date modified Type Size
|| MechiRiceCakeDXT1_b0.bin 1/ BIM File 13 KB
| ] MochiRiceCakeDXT1_c0.bin 1/2 BIM File 13 KB
| | MochiRiceCakeDXT1_b0.bin.esdm 1/ ESDIM File TKE
| ] MochiRiceCakeDXT1_c0.bin.esdm 1/2/2024 €20 pm ESDIM File 1KB

Users must download the converted bitmap resources, either *_b0.raw and *_c0.raw or
*_b0.bin and *_b0.bin, into the root directory of an SD card. Subsequently, insert the
SD card into the hardware module. There is no requirement to download the .esdm file
format onto the SD card.

Output Format for DXT1L2:
The DXT1L2 output format closely resembles DXT1. When ESD is converted, two file

formats are produced: *_bO0.raw and *_cO.raw, or alternatively, *_b0.bin and *_b0.bin
(if the compressed flag is selected).

<« MewProject3é » Build » IDM2040-7A » Data v O Search Data
~ MName Date modified Type Size
le @ MochiRiceCakeDXTI1L2 c0 1/2/2024 6:40 pm FLAW File 19 KB
@ MochiRiceCakeDXT1L2_b0 1/2/2024 6:40 pm RAW File 19 KB
|| MochiRiceCakeDXT1L2_cO.raw.esdm 1/2/2024 6:40 pm ESDM File 1KB
|| MochiRiceCakeDXT1L2_bD.raw.esdm 1/2/2024 6:40 pm ESDM File 1KB

To use the converted bitmap resources, users need to transfer either *_b0.raw and
*_cO0.raw or *_b0.bin and *_bO0.bin files to the root directory of an SD card. It's
important to note that there is no need to download the .esdm file format onto the SD
card.

Output Format for DXT1PALETTED:
If the DXT1PALETTED format is chosen in ESD, it undergoes conversion into three file

formats: *_b0.raw, *_index.raw, and *_lut.raw. Alternatively, when the compressed flag
is selected, the conversion results in *_b0.bin, *_index.bin, and *_lut.raw.

MNewProject » Build » VMB16C30A » Data v O Search Data ye
-ORA Name Type Size Tags

| | MochiRiceCakeDXT1PALETTED_bl.bin BIM File 16 KB

| | MochiRiceCakeDXT1PALETTED index.bin BIM File 9KB

| | MochiRiceCakeDXT1PALETTED_bD.bin.esdm ESDM File 1KB

|| MochiRiceCakeDXT1PALETTED_index.bin.esdm ESDM File 1KB

@ MochiRiceCakeDXTIPALETTED lut RAW File 1KEB

To utilize the converted bitmap resources, users should download either *_b0.raw,
*_index.raw, and *_lut.raw or *_b0.bin, *_index.bin, and *_lut.raw files into the root
directory of an SD card. Following this, insert the SD card into the hardware module. It's
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important to note that there is no need to download the .esdm file format onto the SD
card.

Support extended font format \

Unicode font file can be added to a project by clicking File -> Add from the menu bar
and in the Property window, input font size and character set as desired.

Properties

Property Value

urce File Proxy)
File Mame Resources/KaoriGel ttf
Mame Font
Category
Format
Font Size

Charact

v True

False

Figure 10 - Font size and Character set

Once the font resource is ready, add a widget, such as ESD Label, ESD Button to
project. In Property window, select appropriate “Font Resource”.

Properties
Property Value
(E
ESD Label
Static
0.00
v True

]
23

Width
Height
Auto Resize ESD_AUTORESIZE_HEIGHT

Theme Ft_Esd_Theme_GetCurrent

Alpha 255
Font 3
Font Resource

OPT_ALIGN |
OPT_ALIGN_TOP

Figure 11 - Select Unicode Font Resource
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BILSTENET
PBRIKXSITSVET

GCood morning

TETT  OUR

Figure 12 - Unicode font applied for Label and Button

ASTC Encoder

Since ESD 4.12, the ASTC encoder is upgraded to version 2.0. This is a new version of
ASTC encoder, which is responsible for the image conversion process to ASTC format. It
is from ARM and claims 30% faster performance than ASTC encoder 1.0.

Video Converter

ESD enables users to add video format into project and converts it to Eve specific format
by employing ffmpeg.

It eases the procedure to add the video playback functionality in ESD project. In ESD
examples project playvideo is added to play an mp4 video and avi video, After that the
videos are converted to mjpeq format and played.

Support Animation ‘

ESD enables users to add EVE specific animation file (.anim) into project. The key
features are:

o auto generation of c file and widget files
o thumbnail
o start and stop signals
User can convert .gif file to .anim file with EAB tool.
The steps to add an animation is as below:

1. Convert .gif to .anim with EAB tool

2. Add the .anim file into a ESD project

3. Drag the animation widget from user widget (automatically generated) to the
page which includes the animation

4. Create customized start and end signal, and connect them to the corresponding
slots on animation widget
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Figure 13 - Create animation in project

The example project PlayAnimation showcases how to play and stop an animation. The
screencast video “playAnimationtutorial.gif” under the same folder records the procedure
to design the example project.

Generate Flash file and write Flash file to device

Resources can be loaded from EVE-connected flash or RAM_G. ESD can generate Flash

file for BT81X projects, then uploads the flash file to the device by pressing the #
[Build and Upload to Hardware] button.

Properties
Property Value
{ urce File Proxy)
Fi ame Resources/Lenna_120.jpg
MName Bitmap
Category
Format COMPRESSED_RGBA_AS
rEs v True
v True

C
F
L
Cell N
D
P
v
H

Figure 14 - Mark resource as storage in Flash

Run Executable

Upload Flash and Run Executable

Figure 15 - Upload Flash file to device
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LittleFS File System with EVE connect flash memory \

The LittleFS is a fail-safe file system designed for embedded systems, specifically for
microcontrollers that use external flash storage. BT815 and above devices support flash.
The AssetBrowser example project demonstrates the utilization of the LittleFS file system
in ESD. Kindly review the following steps outlining how to use LittleFS within the project.

1) In the ESD Project properties, it's essential to ensure that the LittleFS Flash file

system is selected as "True"

Propert
(Linked File Proxy)
File Name
Build Target

Name

~ Build Targets

IDM2040-7A
Project

1
IDM2040-7A

te 0

v True
v True

EVE_ADAPTIVE_FRAMIE...

Figure 16 - LittleFS enable option in Project

2) Within the Resource Image properties, it is imperative to choose the Resource

type as "ESD_RESOURCE_FLASH".

Properties

Property
Category
Format
Compressed
Resource Type
Cell Height
Cell Names
Persistent
Width

Value

COMPRESSED_RGBA ...

False

ESD_RESOURCE_FLA ~

Figure 17 — Selected the ESD_RESOURCE_FLASH

3) Initially, call the Esd_LittleFS_Mount() API function from the C source code within
the project. This API verifies if LittleFS is enabled. Upon verification, it proceeds
to invoke the Esd_LittleFS_Configure() and Ifs_mount() functions.
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) — o)

ith the file

Figure 18 - C source file in the Project

Figure 19 — ESD_ LittleFS.c file in ESD_Core

4) Open the directory using Ifs_dir_open(lfs, &dir, "/") API function, and read each
entry in the directory with while loop using Ifs_dir_read(Ifs, &dir, &info) API
Function and get the output File Name and File Size.

(Lfs dir open(lfs, &dir, "/°

// Read each entry in the directory
(lfs_dir read(lfs, &dir, &info) > 0)
{
/{ If the entry is
(info.type — LFS_TYPE REG)
i
/4 Call the Usr_AssetBrowser_AddWidget function with the file name and size

addWidget (context, info.name, info =N

}

/{ Close the directory
1fs dir close(lfs, &dir):;
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5) Generate rows consecutively using the “addWidget(context, info.name, info.size)”
function, including the image file name, file size, and Preview push button.
Additionally, within this function's verification process, rows won't generate if the
file name contains ".esdm". However, if the file name doesn't contain ".esdm",
the rows will be created as planned. For further details about ".esdm", please
refer to page 55.

ESD Asset Browser | e

Catgirl.astc 256.00 KiB
Circle.astc 256.00 KiB
Fireworks.astc 256.00 KiB
Seascape.astc 256.00 KiB

Figure 20 - Show all the images name in the project AssetBrowser

6) After clicking the Preview button, trigger the execution of the
loadResource(context) function. Inside this function, set the current image file
name to bitmapinfo. Proceed to retrieve the flash address using
Esd_BitmaplInfo_LoadFlashAddress(&context->BitmapInfo) and then assign
bitmapinfo with the flash address into the Image Viewer.

loadResource (Usr_AssetPreview *context)

1: /f Set defaults
xt->0wner) ; // Set the filename in the LittleF5S filesystem
loaded from the Flash filesystem
itmap
in advance if the

Circle.astc

Figure 21 - Show preview image in the project AssetBrowser
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Restructured EVE HAL Library |

EVE HAL Library contains C source files, and a sub-folder “Hdr” that comprises of the C
header files. The EVE HAL Library comprises the source code for the EVE HAL platform,
the header files for the EVE HAL platform, and coprocessor commands.

Memory management

Some of the widgets in ESD will use heap memory, in other word, malloc and free will be
used. In the embedded world, it is not recommended due to multiple drawbacks of using
heap. However, it is not easy for ESD to fully use static memory because it is an Ul
design tool. So, a memory pool management module is developed in ESD4.16 onward,
with this implementation, user can restrict the heap memory usage into a controlled
range as below:

~ Definitions

101

Il
21

Libra

Figure 22 - Config the memory

Figure 22 shows that 2 variables pre-allocated memory and Memory limit are defined in
the properties of the root project to configure memory allocation. Pre-allocated memory
is the estimated memory usage of the project, and memory limit is the max value can be
assigned to the project, if the pre-allocated memory is not enough due to some reasons,
ESD will try to extend the memory up to the memory limit. The minimum values of pre-
allocated and memory limit are 0 because not all the widgets use heap memory. The
default values are 72456 for Memory Limit and 36228 for Pre-allocated Memory, and
user should modify them according to the real memory usage of their projects.

Ul enhancements ‘

The following User Interface related enhancements have been added to ESD -

Filter for Library Browser and Project Browser window

More comprehensive toolbar buttons for platform description
New menu to clean up unused/generated files in project
Simplify the process of adding new resources into project
Added context menu for document tab

Impacts of ESD 4.X updated features \

Since the new/updated features of ESD 4.X may cause API changes, existing ESD 3.0
projects are not fully compatible with ESD. Although ESD 4.X has the utility inside to
detect and migrate opening ESD 3.0 project, it may still not work as expected.

e ESD Layouts: A new category of widgets “"ESD Layout” are introduced into the Library
Browser, which enables the layout feature.
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e ESD Widgets: A new set of widgets are introduced into "ESD Widgets” category in the
library. These set of widgets are to be used in constructing the pages. The nodes
under the “"ESD Render Functions” are not supposed to construct page as it has no
widget interface and the layout widget is unable to manage them.

Migrating from ESD 3.0 to ESD 4.X project \

When ESD 4.X opens an existing ESD 3.0 project, it will prompt users to migrate to the
latest version. If user chooses not to migrate, ESD 4.X will not open ESD 3.0 project.

MIGRATION NOTES

1. Please back up your project if you are not sure about
the migration. The migration process will overwrite
the project and it cannot be reversed. -

2. The migrated project file will be renamed from App.main
“* . esd3” to “*.esd”. < Connections

3. The target module of the opened project will be
redirected to two built-in platforms after migration.
So, if the target module is in 320 x 480 resolutions,
users may select the platform “ME810A HV35R”
from “Build Target” combo box from the toolbar and

make a platform switch. fidgets
!'i'l_| Switch Page
O Main Page
& | MainPage.page

VMB316CUI50A ~ [0 vma16C ~ B wvca (300

Build Target

In some cases, if an existing ESD 3.0 project cannot be
migrated to ESD 4.X, then users are required to migrate manually.

e The variable "Parent” of logic is renamed to "Owner” in ESD 4.X.

e X, Y, Width, Height properties in widgets is now accessible through the widget
variable.

e Instead of pointer, struct "Ft_Esd_BitmapCell” shall be used by value in ESD 4.X.

e In order to restore the default behaviour of application logic "App.main”, users may
need to manually move the existing pages into layout widget "Switch Page” in the
Project Browser.
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Setting Platform Specific Properties \

ESD users are able to create one project supporting multiple platforms with various
screen size. Therefore, on different platforms, the same widget may have a different
property value. For instance, for a platform with screen size 480 x 320, the button size
may shrink to a smaller size from the original value for a platform with screen size 800 x
480.

Users can make a property value specific to the current target through the context menu
of the property browser. This can be done by right clicking the selected property of the
current widget. This is illustrated in the picture given below -

Value
ESD3 Label
Active

X
Y

pecific to current target

Width lese ult value

Height

Auto Resize ESD_AUTORESIZE_HEIGHT
Theme Ft_Esd_ GetCurrent
Font Eal

Text ESD3

AlignX OPT_ALIGN_LEFT

Align¥ OPT_ALIGN_TOP

Figure 23 - Making Value Specific to Current Target

User can remove value specific to current target through context menu in property
browser by right clicking the selected property of current widget. This is illustrated in the
picture given below -

Properties
Property Value
(ESD Push Button)
Name ESD Push Button 4
Allocation Static
4.00
v True
19

Remove target specific value 439

Width Reset to default value 120

Height 36

Theme Ft_Esd_Theme_GetCurrent
Font 7

Text Bottom Right
Primary v True

Figure 24 - Removing Target Specific Value
Users can refer to the “ScreenResolution” project under the “Installation/Example”
folder.

Migrating existing projects to new platform

All the existing projects may have been developed using a specific platform. Users can
choose to migrate their projects to a different platform by selecting the appropriate
“Build Target” combo box. If the desired target is not available in the “Build Target”
Combo box, then the user can configure the individual specifications (“"Eve Platform”,
“Display Resolution” and “Host Platform”) of the target by selecting the appropriate
combo boxes.
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Advanced User Settings |

Advanced users are allowed to configure the ESD settings to better assist them in their
GUI application development with EVE products. The Advanced User Settings allow the
user to turn on/off specific features and functions in the ESD. This section shall provide a
brief explanation on the usage and effect on the ESD. As it involves modifying the
application configuration file, it should only be carried out by someone with adequate
knowledge. It is recommended to leave any advanced settings at their default settings.

Application Settings ‘

The “Main.config” file can be found in the “Settings” folder under the installation path.
This file contains application wide settings which may affect the interface and behaviour
of the ESD. Users are allowed to modify to suit their application needs. After the
modification has been done, a restart on the application is required for it to take effect.

Below is the list of settings that can be found in the file.

= PortableSettings - Enabling/Disabling loading cenfigue coscompilstion Environment [~
of Host Device Environment settings from the K
from Screen Designer config upon startup.
The loaded settings will be reflected in “Config
Host Device”.

= SimplifiedExport - Enabling/disabling of the [REEN=TT =1
simplified export menu actions. An “Export” . Ctrl+ Shift+E
option will be displayed under the menu bar if ;
it is disabled.

. " . . ) MNew Project Ctrl+N
The “Export” option will be shown under file

r oy - Open Proje C 0
menu if it is enabled. Open Project CarkC

Save Project As Ctrl+Alt+5
Close Project Ctrl+Shift+W

Clean and Close Project Ctrl+P

Export as Pico Project Ctrl+Shift+E

= Hiddentypes - Hide types from library and menu interface. The listed parameters
under the “HiddenTypes” will be hidden.

o _GroupHidden - A new set of commands will be
made available to user when it is removed from the
hidden state. These controls are mainly to be used
by advanced users.

o _WidgetDocument - Allows the user to create new
customised widget.

Color

Cmd_gradient
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o _LogiclncludeHeader - This allows the user ESD Layouts
to use “include header” logic node under the ESD Render Fundlions
library which helps to add a header file into ESD Themne

project. ESD Utilities
ESD Widgets
Lagic Flow
= Condition

o _LogicWatcher - This allows the user to L Sequence
access "“Watch Variables” logic node
which helps to watch multiple variables
for change.

T Switch
. Switch Value
f Set Vanable

. Watch Variables
1 Logic Interface

o _SourceFile - This allows the user to add new empty .c file to the project.

= Enablelnspector - Enabling of Inspector [
window which is useful for debugging. Raw

Live Record

Inspector Error List
= ShowBitmapHandleUsage - Displaying of bitmap handle usage in status bar.

" KeywordS - List of keywords to be ¢ File object name conflicts with a reserved keyword X
avoided when naming ESD file object.
An error display message box will be
shown if there is a conflict with the
reserved keyword.

x [while.c] has a reserved keyword as its name. Please rename the filename.

oK
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Troubleshooting \

If you build the project with the incorrect host platform, errors may be displayed. Always
ensure to choose the correct EVE host platform. Refer to additional details for further
information. See the table

MOk - EDWSOIZ <

ESD Actor Animators

As depicted in the figure above, an error commonly arises when the Eve platform
VM816C does not correspond to the host platform MM900x. Ensure that you choose the
correct host platform, namely FT4222.

| #e

........

3

As depicted in the figure above, if ESD encounter an error during the creation of a new
project using the build targets VM816C50A or VM816CU50A due to an incorrect EVE
platform. Please make sure to select the correct EVE platform, which is VM816C.
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There is a welcome dialog which will be popped up when ESD is started.

e Welcome > |

” P o oPTTTTY e o afLaginPattern.esd

/Users/wu.jian/Documents/Dacuments/ESD-Project/NewProject/test16/test16.esd
/Users/wujian/Documents/GitHub/ESD30Pratatype/Distrib/Examples/Intermediate/CircularGradientWidget/CircularGradientWidget.esd
/Users/wu.jian/Documents/GitHub/ESD30Pratatype/Distrib/Examples/Advanc ed/WashingMac hine/WashingMachine.esd
/Users/wu.jian/Do cuments/GitHub/ESD30Pratatype/Distrib/Examples/Intermediate/Signal Switch/Signal Switch.esd
/Users/wu.jian/Documents/Dacuments/ESD-Project/NewProject/test15/test15 esd
/Users/wu.jian/Documents/GitHub/ESD30Pratatype/Distrib/Examples/Basic/BinaryConditian/BinaryCanditian.esd

9 C:/Users/wu.jian/Documents/GitHub/ESD30Pratatype/Distrib/Examples/Basic/AutoSwitchlayout/AutaSwitchLayaut, esd

; C:fUsers/wu jian/Dacuments/GitHub/ESD30Prototype/Distrib/Examples/Advan ced/WeatherStation/WeatherStation esd

Figure 25 - ESD welcome dialog
A: Create a new project
B: Open an example project
C: Open a project in the file system
D: Recent project, double click to open

Create a new project:

Mew Project x
')

] MEB10A-HV3SR

[] MEB12A-WHSOR

] MEB13A-WHSOC

[] vms16cusoa

[ vme1ecsoa

A MEB1TEV

|#| GameDuine 3X Dazler for Pica

[ IDM2040

ME810A HV35R

EVE n: EVE Frash :
MEBLOA-HV35R (FT810)

1343

ILI9488 (320x480) Resistive

EVE Host
MM90DEV2A

Liraries: [ f] FT_Eve Hal (Required)
[ Esd_Core (Required)
] FT_Esd_Framework (Required)
[ FT Esd_Widgets (Required)
[ Esd_webStyle_Widgets (Optional)

Figure 26 - ESD new project dialog
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The dialog allows user to create a new project with predefined build target listed in the
picture, or configure a new build target (choose platform, display resolution, host
platform, flash chip and touch IC) with New Target button.

Example projects:

A Examples ? X

Inter

S0 Aclor Animalors

ESD

ActorAnimators AnimatedLayout AutoSwitchLayout BasicMath
Resolution: 800x480 Ri e 800x480 Resolution: B00x480 Resolution: B00x480

o=

Equsl
]

BasicWidget EinaryCandition EitmapFormats ClockTimer
Resalution: B00x480 Resalution: B00x480 Resalution: BOOx480 Resalution: BOOx480

ESD

First Page

ColarMath ColarPicker ConditionalFlow DynamicSwitch
Resalution: B00x480 Resalution: B00x480 Resalution: BO0x480 Resalution: BO0x480

Figure 27 - ESD example prjects dialog

A: Tab which represents 3 different categories of example projects, user can switch the
category by clicking it.

B: Thumbnail of the project, project name and default resolution

C: Search bar which enable user to select keyword, keyword will match project name
and project description. Dialog will update view and only show the matched projects
when user input a keyword

D: Project description

E: Open button, it will open the selected project.

F: Back button, show original welcome dialog if this button is clicked.
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User can choose to show welcome dialog again by below menu if it is closed:

File Edit PBuild Toaols Miew Help

MNew
Add
Save Ctrl+5 : AppScreen.page FitstPage.pag
i

MES17EY

Close Ctrl +W 80
1

Sawe All Ctrl +5hift +5 D
Ctrl+N '

Mew Project

120 200
1 1

Open Project Ctrl+0

| Save Project As Crl +Alt+5
Close Project Ctrl +Shift +W
Clean and Close Project Ctrl+P
Export as MSVC Project Ctrl +Shift +E
Show Welcome Dialog Ctrl +Alt+W

Figure 28 - ESD show welcome dialog menu
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The Graphical User Interface |

ESD user interface has the following components:

Menu Bar
Toolbar
Project Explorer
Screen Layout Editor
Logic Node Editor
Library Browser
Error List/Inspector
Output window
Property Editor

0 Status Bar

HOONOOULANWNE

Option

BITMAP_HANDLE RAM_D 12% RAM_G: 0kB W Fissh 418

Figure 29 - EVE Screen Designer User Interface Components
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The Menu bar displays the headings for each drop-down menu. According to the
function, the commands are grouped under each of these menu headings.

Menu bar File Edit Build Tools
Menu item hlews
selected A Add
Save
Close
Menu items Save

M =

Al

Project

Open Project

3dWeE

Project As

|:;| ose P rlj_i ect

: Newfolder3.esd

: Mewfolder.esd

3: AutoSwitchLayout.esd

Exit

View Help

4 . Legic
B Actor
Ctrl+S M Widget
Ctrl+W M Page
Ctib+Shiftes ‘2 Theme
Ctrl+ M B Source Files
Ctrl+ 0 B Logic Source Files

Ctrl+Alt+5
Ctrl+5Shift+W
Ctrl+P
Ctrl+5hift+E

Ctrl+Alt+W

Alt+F4

Figure 30 - Menu bar

Sub menu item

The following table provides the list of Menu/Submenu and its description -

Menu Submenu
File New

Add

Save

Close

Save All

New Project
Open Project
Close Project

Clean And
Close Project

Export as

Logic
Actor
Widget
Page
Theme
Source
Files
Logic
Source
Files

Description

Creates new file for the current project

To add existing file(s)/resource (such as bitmap, C source
file etc.) to the project

To
To
To
To
To
To
To

To

save the current file
close the current file

save all the files in the current project

open a new project

open an existing project

close a current project

clean current project then close it

export as Eclipse project. This will only be shown when
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Eclipse supported platform is selected
Project
Export as To export as MSVC project. This will only be shown when
MSVC supported platform is selected
Project
Export as To export as Pico project. This will only be shown when
Pico supported platform is selected
Project
Show To show welcome dialog which include create new project,
Welcome show example projects, open project in file system and
Dialog open recent projects options.
1:<Project To open recent projects, up to 10 projects
Path>
Exit To close the ESD application
Edit Undo To reverse the action of a recently performed action
Redo To revert the effects of the undo action
Cut Cut the selected node(s) to clipboard
Copy Copy the selected node(s) to clipboard
Paste Paste the node(s) from clipboard
Find Find a specific text string in source editor
Replace Replace a specific text string in source editor
Build Build To generate an executable file
Executable
Build and To generate an executable file and upload to hardware
Upload to
Hardware
Browse to To navigate to the folder under which the executable file is
Executable located
Tools Generate To generate a Class ID for user widget or layout. It is a
Class ID hash from the widget name and generally useful when
user prefers to write code in “C” language.
Input class name
Click this button to
generate the symbol name and its hash value
used in widget definition code.
Clean To clean the generated files which are not in use
Unused
Generated
Files
Configure To show the current tool chain path for the host device,
Cross- and user can change the paths according to their own
compilation configuration.

Environment

Configure cross-compilation Environment
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View Project
Library
Properties To display or hide a component view. By default, all the
Inspector components are displayed.
Error List
Output
Help User Guide Opens the User Guide with respect to current version
Widget Opens the user guide which describes the in-built widgets
Introduction in ESD.
Guide
About Displays the version details
3 Party Displays the copyright, disclaimer and license information

of the 3 party software
Table 2 - Menu & Description

Toolbar

The Toolbar provides easy access to common functions (in the form of icons) such as
new file, save file, undo, redo etc.

New Save Undo Simulation Recompile
Add Save Redo Restart
All

Figure 31 - Toolbar 1
Platform Screen Flash chip Build Build and Upload
Target Size Type Executable to hardware

EVE Module type MCU Platform TouchIC Toolchain Programmer
type

Figure 32 - Toolbar 2

The following table provides the list of toolbar functions and its description -

Toolbar Function Description

New To open new Logic/Actor/Widget/Page/Theme/Source Files/Logic Source
Files

Add To add existing resource (such as bitmap, C source file etc.) to the project

Save To save the currently open file

Save All To save all the files in the current project

Undo To reverse the action of a recently performed action

Redo To revert the effects of the undo action

Simulation A toggle button which starts or stops the simulation mode.

- This state indicates that the ESD 4.14 is in simulation mode.
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Clicking this button stops the simulation.

- This state indicates that the ESD 4.14 is out of simulation mode.
Users can drag/drop widgets or edit them safely.

Restart To automatically restart the EVE emulator. Clicking this button will force the
simulated screens to be re-drawn.

Recompile To recompile the whole project’s source code using ESD built-in TinyCC
compiler. It is a mandatory procedure for simulation.

Platform Target Select the hardware platform as source code building target

EVE Module Type To select EVE module type

Screen Size To set screen size

MCU Platform Type @ Select the building configuration when toolchain is invoked to build

Flash Chip Type To select flash chip for BT81x based series platform

Touch IC To select capacitive touch controller type

Build Executable Build the project files

Toolchain Select toolchain to build

Build and Upload Upload Flash file to device and/or run executable file

to Hardware

Programmer Select executable mode

Table 3 - Toolbar & Description

119 - 16:26:5?"' lE isxx Emulator IJErar}'_\i_B.CI.G} - Emulator

ME313AU-WHS0C ~ | O Mes1zau-wr ~ | Ewvea (goox ~ | [ L FT4222 x86 Release =

AppScreen. ¢ App.main ™

MMIZOEV-Lite
FT4222

Figure 33 - MCU Type is not applicable to selected platform

The red exclamation mark in the image above means those MCU types are not applicable
to the currently selected platform.

Touch IC configuration

FT811, BT815 & BT817 work with capacitive touch controllers. Currently, only the
following capacitive touch controllers are supported by EVE:

FocalTech: FT5xx6 / FT6xx6 series IC
Goodix: GT911/GT9271 series IC.

ESD users can configure the touch IC controller by using the touch IC configuration
combo box as shown below.

More information on the touch controllers can be found in AN _336.
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W Disabled
= | [ HDp * | WA Raph = || E T Focallech © RPZ040_R

' Goodix

ASTCPagel.page App.main ARGEPage.page Resistive

Figure 34 - CTP configuration

The Project Explorer window organizes all the files used in the project in a tree view. It
also lists out all the resources used by each file. Project explorer allows users to navigate
each page of the project.

Project

Figure 35 - Project Explorer window

In case of many items existing in a project, user can use filter textbox in order to get a
sort list of items. Text that matches the filter is highlighted. Regular expressions are
supported.

Project

Figure 36 - Project Explorer Filter
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Screen Layout Editor \

The Screen Layout Editor displays the rendering output of EVE and allows users to edit C
source code. The page/widget/main files can be opened and edited in this editor.

MainPage.c App.main **

ESD

Al &
Bl

BliitonZ

Bltian's

MainPage.c '

-on Text {(ButtonState *context)

context->Text;
-

Figure 38 - Screen Layout Editor - MainPage.c (C Source Code)

It shares one view port with the logic node editor. Users can adjust the size of the screen
layout editor by dragging the splitter handle.

Users can drag and drop the widgets from the library browser to form the layout when
simulation mode is "off”. For the other kinds of logic nodes, if the EVE rendering process
is not defined, screen layout editor does not allow them to be dropped in.

App.main AppScreen.page

Close tab 160 180 200 22
I

| | |
Close other tabs

Close all tabs

Figure 39 - Context menu on Tab bar
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Users can right click on tab bar to active a context menu. Those menu items are
described in table below.

Menu Description

Close tab Close the current tab

Close other tabs Close all tabs except the current tab
Close all tabs Close all tabs that were opened

Logic Node Editor

The Logic Note Editor allows users to layout logic nodes and to establish connections to
create logic maps. Users can drag and drop a logic node from the Library Browser
component to the Logic Note Editor in order to create connections.

Fixed Position Set Variable ESD Label 4

o Painter
Target Theme
Font

Pointer

v

Width Set Variable 3

Height O
Target

Condition Set Variable 4

O
Target

Set Variable'2 Pointer

]
Target

Figure 40 - Logic Node Editor
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Library Browser \

The Library Browser allows the storing of all the available logic nodes and resources in
ESD that includes both built-in and user-defined ones. Users can view these logic nodes
by category and select one for their project.

Library

F ESD Layouts
ESD Render Functions
ESD Theme
ESD Utilities

5D Widgets
Legic Flow
Logic Interface
Uszer Actors
User Functions
User Layouts
User Logic

User Pages

User Resources
User Widgets

Figure 41 - Library Browser

The following table provides the ESD library name and its description -

Library Name Description

ESD Layouts ESD built-in layout widgets and relevant utilities

ESD Render Functions ESD built-in Render functions

ESD Theme ESD built-in basic theme manipulation functions

ESD Utilities ESD built-in utilities

ESD Widgets ESD built-in widgets

Logic Flow ESD built-in logic node for control flow

Logic Interface ESD built-in logic node for interface

User Actors User defined actor logic node. It is empty by default.

User Functions User defined functions. It is empty by default.

User Layouts User defined layouts. It is empty by default.

User Logic User defined logics. It is empty by default.

User Pages Pages added by user. It is empty by default if no page is created.

User Resources Resources added by users (For example: bitmap). It is empty by
default.

User Widgets Widgets created and added by users. It is empty by default.

Table 4 - ESD Libraries
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Error List ‘

The Error List is a dock window which shows the message output from ESD, while saving
and recompiling the project files. Any error message displayed in this window indicates
that the generated source code for the current project is unable to be executed
successfully. Users need to double check the logic defined in /ogic node editor or the
user-defined source code in the project.

Error List

Connection targ
¥ Duplicate data inp

Inspector Error List

Figure 42 - Error List Window

The Output component is a docked window which shows the message output from the
EVE emulator and Toolchain.

Cutput

Simulation
Build

Figure 43 - Output Window

To check a message from the EVE emulator, click “Simulation” from the drop-down list.
To check a message from the EVE Toolchain while building generated source code, click
“Build” from the drop-down list. This window is automatically updated during simulation
or building.
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Property Editor \

The Property Editor allows user to edit the properties of selected logic nodes. The sample
screenshot given below shows the property editor of an ESD Push button.

Properties

Property Value

ESD Push Button

Static

1.00

v True

393

120

36
Ft_Esd_Theme_GetCurr...

27

Button

1000

Figure 44 - Property Editor (ESD Push Button)

Status bar \

The Status bar is found at the bottom of the user interface. It primarily displays the
current status of any of process or job that is being handled by the application. For
example, if the user is performing a C compilation, then the compilation status of the

generated C code is displayed.

The percentage of RAM_DL The size of RAM_G memory used Simulation status
memory used by the current page by the current page (whether in progress
or not) &

*

“  Render

v C compilation 100%
Y |
Y $ )

The percentage of Flash The compilation status of the

RAM_DL:

BITMAP_HAMNDLE:

The percentage of bitmap memory used by the generated “C” code. Project
handles used by the current current page cannot be simulated if the
page compilation fails.

Figure 45 - Status bar

47

Product Page
Copyright © Bridgetek Pte Ltd

Document Feedback



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.7

)

\/
o Brid k BRT_AN_029 EVE Screen Designer 4.18 User Guide
’ rl gete Version 1.7

.0
* BRIDGING TECHNOLOGY

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Application Project Structure \

An application consists of one or more pages. Each page in turn may contain one or
more widgets. Widgets and pages are connected via connection lines so that the screen
logic is defined.

The application model follows a strict hierarchical structure where all the pages are
owned and managed by the application, and all the widgets are owned by their
respective pages. The visibility and memory lifetime of the widgets are thus managed on
a page-by-page basis.

By design, all widgets and pages are generated to be entirely modular and self-sufficient.
Any interaction between the widgets and pages is therefore required to be routed
through the hierarchical chain. (Only node connections exist between the directly
connected nodes in the hierarchy.)

[ App.main J

l D Application

Page

S | Switch Page Layout

Widget

AppScreen.Page

s
T
| I '

Page Page Page

Figure 46 - Application Project Structure

File Name Description

*.esd Project file - This XML file describes what files are included in this project. This file
is unique for the whole project.

*.main Logic file - This XML file describes the application-level logic. By default, it is
named as “App.main” and is unique project wide.

*.page Page Node Definition file - This XML file describes what widgets are contained and

connected in each page. By default: “"AppScreen.Page” is added, where a switch
page may be included for control on page transition. A page can contain other
pages, but switch page is required for page transition control.

*.widget Widget Node Definition file. This XML file describes a widget detail.
A widget can contain other nodes, which may include widget node, actor node and

logic node.
*.actor Actor Node Definition file. This XML file describes the actor node details.
*.logic Logic Object Definition file. This XML file describes the logic node details.
*.theme Application Theme Definition file. This XML file describes the theme detail.
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*.h C language source header file

*.cC C language source body file

*.png, Image resource files

*.jpg,

*.jpeg

*.anim Animation file converted by EAB tool

Note: The file names listed above shall NOT be conflicting with the C standard library
function as well as windows header files. Here are some examples: fopen, windows,
winbase, math, printf, realloc. ESD simulation process may give errors and fail, if user
gives the file name of their widgets, logics, images, or any resources with these reserved
names. Therefore, ESD enforces the ‘Usr_’ prefix to all the new/renamed widgets, pages,
functions, actors, as well as source file, theme, logic source file etc, in order to ensure
that the simulation process succeeds without error.

Application Workflow

The workflow given below illustrates how to create an EVE based GUI application:

Screen Logic Node Source JIT EVE Emulator
Layout Editor Editor

O la 1b

\ 4 A 4

A{Design Layout] —»[Design Logic]

Generator Compiler

2 » Generate C é» Build

4b 4c Y

Simulate

Figure 47 - Application Workflow

The 5 main modules that comprise the application workflow are the Screen Layout
Editor, Logic Node Editor, Source Generator, JIT Compiler(TinyCC) and EVE Emulator.
Among these, Source Generator, JIT Compiler and EVE Emulator are the back-end
modules which have no UI exposed to end user. The compiler is a JIT style C compiler,
i.e., TinyCC compiler, which compiles and links the generated code into executable. The
executable is invoked by the emulator module for simulation.
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The application workflow starts by design layout (1a) or design logic (1b); Upon user
saving the changes, it will trigger C code generation (2), then the compiler will try to
build the generated c code; if any error encountered during building, then user needs to
continue on design layout (4b) or design logic (4c); or if no error found, then the
emulator will start simulating (4a) the project. Users will be able to upload (5b) the
binary to the EVE chips or export (5c) the project as eclipse C project.

Design Layout using Layout Editor

Users need to determine how many pages are included in the project and what widgets
are to be contained in each page. After a page is created, users can drag and drop the
widgets to design the appearance of the page in the screen layout editor. This process
determines how many screens are shown in the project and how they look like together.

Custom Widget

ESD provides a set of built-in widgets for users to construct screen layouts. Additionally,
if the built-in widgets do not meet the design requirement, users may define and design
custom widgets.

Add Bitmap Resource

To display a bitmap on the page, users need to add a bitmap resource into the project.
The following steps will provide guidance on how to add a bitmap resource:

File Edit Build Tools View File Edit Build Tools View Help

a. Create a New Project (File > New - S
Project) or open an existing Project ¥
(File > Open Project). B Save

Close

= Save All = Save All

MNew Project MNew Project

Open Proje

b. Click File » Add from the menu. File Edit BuildeTaols View
New
B Add b
J M Save
Close
= Save All

Mew Project
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c. Browse and select the image file(s) from the file explorer window.
§ Add Existing File .. ]—
K Uscs » Pubic » Publc Documenis » EVE cren Designer » Brompes » - & |

Organize « MNew folder

Bl Desktop - Mame Date modified Type
& Downloads ‘

. Advanced 23/1/2017 3:37 PM File folder
| Basic 23/1/2017 3:37 PM File folder
B . Intermediate 23/1/2017 3:37 PM File folder

1=l Recent Places

4 Libraries
@ Documents
J? Music
[ Pictures
=l Subversion

EE videos

All Files (*.%)

. Computer Legic (*logic)

£ | ol Disk (C Actor (*.actor)

je Local Disk (C:) Widget (*widget)
—a Recovery (D) Page (*.page)
a HP_TOOLS (E) Applicatio.n Legic (*.main)
¥ Websites (\\glaappsl) (W:) <
S general (\\glafsl\Data) (X:)
S# L Subramanian (\\SMNGFSIAL
=8 neneral Mennfel\Natal (71 7 Theme file ("theme

File name: ~ | AllFiles (+7) ~|

[ open || concel |

Upon adding the file, users can drag and drop the ESD Image widget to the desired page
and select the bitmap cell (which is default at cell 0) accordingly.

Configure Bitmap Resource

Users can configure a bitmap resource via the Property Editor. Select the image file
from the project browser and check the Property Editor.

Property Value
(Resource File Proxy)

File Name Resources/LosAngel...
Name Bitmap
Category

Format PALETTED565
Compressed v True
Flash False

Cell Height

Cell Names

Persistent

Prefer RAM

Width

Height
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Property
File Name
Name
Category
Format

Compressed
Flash
CellHeight

CellNames

Persistent
Width
Height
Prefer RAM

Value/Description

Name of the image file

Resource Type Name. In this case, the selected resource type is Bitmap.
Category of the selected object

Image Format - The target format of bitmap can be -

L1/L2/L4/L8

RGB332/RGB565
ARGB1555/ARGB2/ARGB4
PALETTED4444/PALETTED565/PALETTEDS8
DXT1

JPEG (Decoded into RGB565 format only)
PNG (Decoded into RGB565 format only)
COMPRESSED_RGBA_ASTC_4x4_KHR
COMPRESSED_RGBA_ASTC_5x4_KHR
COMPRESSED_RGBA_ASTC_5x5_KHR
COMPRESSED_RGBA_ASTC_6x5_KHR
COMPRESSED_RGBA_ASTC_6x6_KHR
COMPRESSED_RGBA_ASTC_8x5_KHR
COMPRESSED_RGBA_ASTC_8x6_KHR
COMPRESSED_RGBA_ASTC_8x8_KHR
COMPRESSED_RGBA_ASTC_10x5_KHR
COMPRESSED_RGBA_ASTC_10x6_KHR
COMPRESSED_RGBA_ASTC_10x8_KHR
COMPRESSED_RGBA_ASTC_10x10_KHR
COMPRESSED_RGBA_ASTC_12x10_KHR
COMPRESSED_RGBA_ASTC_12x12_KHR

Set bitmap compression on/off

Set this to store the resource in the Flash

The pixel number of one cell. For example, if the bitmap width is 240 and height

is 240, then it can be defined as two cells with “CellHeight” - 120 or four cells with

“CellHeight” - 60. Cell Height default at 0 which means there will be only one cell

no matter how large the bitmap it is.

This field will enable system to create a list of n number of user defined cell

names instead system generated which is suffixed with " x".
CellHeight MochiRiceCakeDXT1_Cell2

* CellMames MochiRiceCakeD¥T1_Celld

(0] MochiRiceCakeDXT1_CellA
[1]

MochiRiceCakeDXT1_CellC
MochiRiceCakeDXT1_End

[2]
E
[4]

Keeps the memory persistent even if the bitmap is not displayed when it is true.
The width of bitmap image in pixels

The height of bitmap image in pixels

For ASTC images, resources can be rendered directly from Flash without the need
to store it to RAM_G. If Flash flag is True to load ASTC image from Flash directly.
If Flash flag is False, Resources will be rendered from RAM_G.

Prefer RAM feature is exclusively available for ASTC format alone.

Table 5 - Bitmap Resource Properties
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Design Screen Logic using Logic Node Editor \

Users can define the dynamic behaviour of an application in this stage. The Logic Node
Editor employs the innovative visual programming idea to help users define logic flows
without coding.

During this stage, users can decide the behaviour mode of both inner-page and inter-
pages. For inner-page behaviour, users can connect the widgets on the page via the
logic node editor adding more logic nodes from the library browser, if necessary.

Inter-page logic behaviour is captured in the application logic, which is normally named
as “AppScreen.page”. Users are required to drag and drop the predefined pages into the
logic node editor and connect these pages via the logic interface. By establishing
connections between these pages using the logic interface, the behaviour that
transcends page boundaries, such as screen logic, is effectively defined.

Evaluate and choose the memory usage of the project \

As mentioned earlier, ESD allows users to configure heap memory usage in root project
properties. It is necessary to decide the memory usage before uploading the image to
hardware. There are several useful debug messages which will be printed in debug mode
which can assist user to make the decision.

;;;;;

Figure 49 - memory pool Ios

The above figure illustrates the use of keyword [Esd MemoryPool] for decision making.

To validate the behaviour of the screen logic, users may need to simulate the project on
the PC before compiling and downloading the generated C code into the target device.
When application logic (AppScreen.page or App.main) is selected, users can simulate the
whole project by clicking [Simulation] button on the toolbar. When the application is in
simulation mode, users cannot drag and drop the widgets into the layout editor. The PC
mouse will act as a touch stylus on the touch panel to interact with the application
directly.
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To validate the behaviour of single page, users need select the page file and open it with
logic node editor before clicking the [Simulation] button on the toolbar. Similarly, users
can simulate the behaviour of other logic node, such as widget, actor by opening it with
logic node editor and clicking [Simulation] button on the toolbar.

Before performing a simulation, it is strongly recommended to save the current project
by clicking [Save all] button. Once the simulation is completed, ensure to switch off the
simulation mode by clicking the [Simulation] button again.

Simulation State Description
ON State - Indicates that the simulation is in progress. Clicking on it will
switch off the simulation. In this state, users will not be able to edit the

page or project.
OFF State - Indicates that currently simulation is not in progress. Clicking
on it will switch on the simulation.

Target selection

ESD provides support for the following built-in build targets -

ME810A-HV35R
VM810C50A
ME812A WH50R
ME812AU-WH50R
ME813A-WH50C
ME813AU WH50C
VM816CU50A
VM816C50A
ME817EV-WH10C
10. ME817EV-WH70C
11. Gameduino 3X Dazzler for Pico
12.IDM2040EV-7A
13.IDM2040EV-43A

PONOUNRAWN =

These build targets typically come with standard |#ueweaa x
configuration which the user can modify within e (BRI
certain limits as per their requirements.

[ vmse16csoa
i 7E

3
ameDuina 3X Dazzler for Pico
ESD also provides a mechanism to create new 4 oweoee
custom targets for new ESD projects. For oton e

example, if the user wants to create a new build & e

target “PC_BT815EMU_WVGA” with PC as Host e HVISR (FT310) -
platform, BT815 as EVE platform, Screen il o438 (3300450) e
Resolution as WVGA (800 X 480) and Flash set to = N

16MB MX25L16. Refer to the Figure 50 and AT

F| g ure 5 1 . Libraries: % ;;TEE:‘E

Figure 50 - New Target button
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#¢ Add Target X

Mame: PC_BT815EMU_WVGA

Description: A new build target platform
EVE Platform:

OROMOE

)
7]
b=}

I:l I
m \
D i
I:l I
I:l i

Mew Define

Figure 51 - Configure custom target

The newly created target can then be set via build target. Refer to the screenshot given
below:

] MEB17EV ~ | OF wxeA (128 ~ | ElFrazz2
MEBT7EV-WHTOC
' PC_BTE1SEMU_WVGA App.main **
80 120 160 200 240 280 | 320 440 480 520
Figure 52 - Select custom build target

Build & Upload ‘

Run Executable

Figure 53 - Build & Upload
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“Build Executable” button builds a project.

“"Build and Upload to Hardware” button will invoke the compiler and programmer, so
that the current project can be build and uploaded into the target hardware. If user
selects x64 toolchain, this button will build and generate an ‘.exe’ application which can
be run on a PC as host environment.

For Pico RP2040 platform, ESD will set up the build environment and trigger cmake and
nmake to build Pico project. An Uf2 image file will be generated and flashed to the Pico
MCU, so user needs to enter Pico flash mode before triggering this option. If user has
failed to do this, a dialog will pop up and requesting user to enter flash mode.

Pico drive not exist,please enter bootloader mode

Please fix the issue and dick retry to deploy again

Retry Cancel

Figure 54 - Pico drive not connected alert

The respective output files generated by "“Build Executable” for different build
configuration and host platforms are shown in Table 6.

Build Target Host Platform Output files
FT90x toolchain *.bin; *.elf
MES10A-HV35R Pico toolchain *.uf2
VM810C50A X64 toolchain (MPSSE) *.exe
FT90x toolchain *.bin; *.elf
ME812A WH50R Pico toolchain *.uf2
ME812AU-WH50R X64 toolchain (FT4222) *.exe
FT90x toolchain *.bin; *.elf
ME813A WH50R Pico toolchain *.uf2
ME813AU WH50C X64 toolchain (FT4222) *.exe
VM816CU50A X64 toolchain (FT4222) *.exe
VM816C50A X64 toolchain (MPSSE) *.exe
FT90x toolchain *.bin; *.elf
ME817EV-WH10C Pico toolchain *.uf2
X64 toolchain (FT4222) *.exe
FT90x toolchain *.bin; *.elf
ME817EV-WH70C Pico toolchain *.uf2
X64 toolchain (FT4222) *.exe
Gamgdumo 3X Dazzler Pico toolchain *.uf2
for Pico
IDM2040EV-7A Pico toolchain *.uf2

Table 6 - Output files for different Build Configuration & Host Platforms
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Upon completing the screen design, it's time to move the project to the next phase of
the workflow - export project. There are three ways of exporting project. They are
“Export as Eclipse Project”, “"Export as MSVC Project” and “Export as Pico
Project”. This function is used to prepare all the necessary files for the MCU tool chain
so that users can make further enhancements such as connecting sensors or external
hardware to a full HMI solution.

On exporting, ESD copies the generated “C” source code, the necessary bitmap
resources and the ESD application framework code into a user defined folder. In ESD, all
the generated files are named as “*_generated.c”. For eclipse export projects,
“.cproject” and “.project” files are generated so that the users can open the project in
FT90X eclipse IDE3. For MSVC export projects, “Project” folder is generated containing
the MSVC compatible project. For Pico export projects, “CMakelLists.txt” and
“pico_sdk_import.cmake” are generated for user to build the project. Additionally, an
optional batch file “pico_build.cmd” is also generated. This allows the user to build Pico
export project in a single step. And in order to use this script, system environment
variable PICO_SDK_PATH needs to be set as the pico-sdk path. Another script
“pico_flash.cmd” will be generated only if ESD project has assets in Flash, run this script
will flash both the flash image and application into Pico board, Pico board needs to be
under flash mode before running this script. Table 7 gives more information on the Build
Targets, Host platform and the corresponding export projects that can be created.

Build Target Host Platform Export Project
Emulator MSVC Project
MM900EV1A, MM900EV1B, MM900EV2A,
MM900EV3A, MM900EV-Lite

MM2040EV Pico Project

ME810A-HV35R Eclipse Project

VM810C50A

Emulator, MPSSE*

MSVC Project

ME812A-WH50R

Emulator

MSVC Project

MM900EV1A, MM900OEV1B, MM900OEV2A,
MM900EV3A, MM900EV-Lite

Eclipse Project

ME813A WH50C

MM2040EV Pico Project
ME812AU-WH50R Emulator, FT4222* MSVC Project
Emulator MSVC Project

MM900EV1A, MM900OEV1B, MM900OEV2A,
MM900EV3A, MM900EV-Lite

Eclipse Project

MM2040EV

Pico Project

ME813AU WH50C

Emulator, FT4222

MSVC Project

VM816CU50A

Emulator, FT4222

MSVC Project

VM816C50A

Emulator, MPSSE*

MSVC Project

ME817EV-WH10C

Emulator, FT4222

MSVC Project

MM900EV1A, MM900OEV1B, MM900OEV2A,
MM900EV3A, MM900OEV-Lite

Eclipse Project

MM2040EV

Pico Project

ME817EV-WH70C

Emulator, FT4222

MSVC Project

MM900EV1A, MM900OEV1B, MM900OEV2A,
MM900EV3A, MM900OEV-Lite

Eclipse Project

MM2040EV

Pico Project

Emulator

MSVC Project

Gameduino 3X dazzler —
Raspberry pi Pico

Pico Project

3 https://brtchip.com/ft9xx-toolchain/
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Emulator

MSVC Project

IDM2040EV-7A

IDM2040EV

Pico Project

Table 7 - Build Targets, Host platform and the corresponding export projects

(* Requires separate MPSSE adapter or FT4222H circuit)

Exported Folder Structure

Table 8 provides the list of folders and files that are created upon exporting the project:

Folder / Files

Esd_Core

FT_Esd_Framework

FT_Esd_Widgets

FT_Esd_Hal
Data
$(ProjectName)

.cproject (for Eclipse export)
.project (for Eclipse export)
ThirdPartyLib

Project/$(ProjectName)_MSVC/
$(ProjectName)_MSVC.sIn
Project/$(ProjectName)_MSVC/
$(ProjectName)_MSVC
/$(ProjectName)_MSVC.vcxproj

CMakelists.txt(for Pico export)
pico_sdk_import.cmake
ThirdPartyLib

pico_build.cmd

pico_flash.cmd

Description
(Common export files)
Contains the application core files.

It is recommended not to make any changes to this folder/
files
Contains the application framework files.

It is recommended not to make any changes to this folder/
files
Contains the widget files

It is recommended not to make any changes to this folder/
files
Contains the hardware abstraction layer files. These files may be
changed to support a different MCU.

Contains the converted bitmap resource data and the flash data
which is used by the current project

Contains the application specific source code
(Eclipse export files)

Eclipse project file

Eclipse project file

Contains third party files such fat filesystem library handler files
(MSVC export files)

MSVC project solution file

MSVC visual studio C++ project file

(Pico export files)
cmake file
cmake file
Contains third party files such fat filesystem library handler files
Build batch to trigger Pico build
Batch to flash both assets and application

Table 8 - List of Folder & File created upon exporting project

Assets

The assets typically include various resources and data files that are bundled with the
application to support its functionality and appearance.
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Bitmap Resources

The bitmap resources used in an ESD project can be saved in a SD card or to flash based
on the selection of flash flag configuration in the ESD.

.astc : The ASTC Bitmap Format for images, there is requirement to copy the .astc file
to the SD card or Flash directory.

.z : The .z Bitmap Format, used for compressed images, necessitates copying the .z file
to either the SD card or the Flash directory.

If Bitmap resources meant for SD card are used in a project, it is converted to *.astc (for
ASTC file format)/*.raw (for other file formats) or *.bin file format (if compressed flag is
selected). Users are required to download the converted bitmap resource into an SD card
root directory and insert the SD card into the hardware module.

The converted bitmap resource is located at:
$(ExportFolder)\data

The bitmap resource file with .bin extension is called to decompress using the EVE
engine command CMD_INFLATE.

As per the Hardware Platform requirements, the SD card must be formatted as a FAT32
file system.

If bitmap resources meant for flash are used in a project, it is converted to a Flash.bin
file. Users are required to download the converted bitmap resource into flash memory of
the hardware module.

The converted bitmap resource is located at:

$(ExportFolder)\data

The bitmap resource file with .bin extension is called to decompress using the EVE
engine command CMD_INFLATE.

Resource Metadata

To support dynamically changing and loading new assets at runtime without binary
recompilations due to hardcoded asset information, EVE Screen Designer generates
additional metadata files with the file extension .esdm appended to the full original
filename for each converted resource.

The contents of the metadata file correspond to the contents of the Esd_BitmapInfo,
Esd_Resourcelnfo, Esd_FontInfo, and Esd_AnimationInfo data structures, packed in a
fixed format to fit within 64 bytes. This size restriction allows the metadata to fit within
the directory record of the LittleFS filesystem when in use with flash storage, and
simplifies loading.
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Common Resource Metadata Format:

The first 12 bytes contain the common fields used for all assets.

Identifier Offset Type Name Description

ESD_METADATA_SIGNATURE 0 uint32 | Signature Serialized byte sequence
equals "RES", "ANI",
"BMP" or "FNT", NUL-
terminated

ESD_ METADATA_VERSION 4 uint8 Version Version of the metadata
format

ESD METADATA_SIZE 5 uint8 Size Size of the metadata
structure

ESD_METADATA_COMPRESSION | 6 uint8 Compression The Compression option
in Resourcelnfo

ESD_METADATA_EXTLEN 7 uint8 Extension The string length of the

Length complete file extension of

the resource

ESD_METADATA_RAWSIZE 8 uint32 | Raw Size The uncompressed size
of the resource, RawSize
in Resourcelnfo

Bitmap Resource Metadata Format:

The bitmap resource metadata format builds on the common format, and has all the
necessary data to populate the Esd_BitmapInfo structure.

Identifier

Offset

Type

Name

Description

ESD_METADATA_WIDTH

12+ 0

int32_t

Width

Display width in pixels

ESD_METADATA_HEIGHT

12 + 4

int32_t

Height

Display height in pixels

ESD_METADATA_STRIDE

12 + 8

int32_t

Stride

Stride of the bitmap
data in bytes

ESD_METADATA_FORMAT

12 + 12

uint32_t

Format

Format of the bitmap
data

ESD_METADATA_PALETTESIZE

12 + 16

uintl6_t

Palette Size

Uncompressed size of
the palette file

ESD_METADATA_PALETTEFILEEX
T

12 + 18

uint8_t[
10]

Palette File
Extension

Filename suffix of the
palette. Concatenated to
the bitmap filename
trimmed by Extension
Length (Paletted)

ESD_METADATA_ADDTLRESEXT

12 + 28

uint8_t[
12]

Additional
Resource
Extension

Filename suffix of the
additional bitmap info
resource. Concatenated
to the bitmap filename
trimmed by Extension
Length (DXT1)

ESD_METADATA_CELLS

12 + 40

uint16é

Cells

Number of cells usable
by the user (up to 256
pages of 256 cells),
excluding hidden cells
(e.g., hidden DXT1
layers)

ESD_METADATA_SWIZZLE

12 + 42

uintl6_t

Swizzle

Swizzle, same 12-bit
format as
BITMAP_SWIZZLE, plus
one bit to enable the
option
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Animation Resource Metadata Format:

The animation resource metadata format specifies the address offsets that the animation
was built with when assembling the flash image. It is currently only used to verify that
the animation matches its current location in flash. The ESD build process adjusts these
offsets on-the-fly while assembling the flash image. At this moment, ESD only supports
displaying animations directly from flash.

Identifier Offset | Type Name Description

ESD_METADATA_FRAMESPTR 12+0 uint32 Frames Ptr | The address of the
frames file that the
object file was built
with. Refers to a
RAM or flash
address depending
on whether the
header object is
loaded in RAM or

flash
ESD_METADATA_FRAMESSIZE 12 +4 uint32 Frames Size of the display
Size list frames file, if O

both frames and
atlas files are

ignored
ESD_METADATA_ATLASBITMAPSOURCE | 12 + 8 uint32 Atlas The address in
Bitmap bitmap source
Source display list format

(can be flash or
RAM) of the atlas
file that the frames
file was built with

ESD_METADATA_ATLASSIZE 12 + 12 | uint32 Atlas Size Size of the ASTC
bitmap atlas file, if
0 the atlas file is

ignored
ESD_METADATA_RECTX 12 + 16 | int1l6 Rect X Display list bounds
of the display list
frames
ESD_METADATA_RECTY 12 + 18 | int1l6 Rect Y Display list bounds
of the display list
frames
ESD_METADATA_RECTWIDTH 12 + 20 | int16 Rect Width | Display list bounds
of the display list
frames
ESD_METADATA_RECTHEIGHT 12 + 22 | intl6 Rect Height | Display list bounds
of the display list
frames
Product Page 61
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Font Resource Metadata Format:

Specifies font measurement characteristics that are not present in the font block, used
by ESD to correctly align and centre fonts.

Identifier Offset Type | Name Description

ESD_FONT_EXTENDED | 12 + 0 uint8 | Type Type of font to load (Legacy or
Extended)

FontHeight 12 + 4 uint8 | First Char | First character in the glyph map (for
legacy fonts)

Baseline 12+ 8 uintl6 | Base Line | Baseline, distance from top of font glyph

CapsHeight 12 + 16 | uintl6 | Caps Caps height of font, measured from

Height baseline

XOffset 12 + 20 | uintl6 | X Offset Offset of left edge of characters in the
bitmap

FontResource ... Font

GlyphResource ... Glyphs

Layout Editor

The Layout Editor allows users to preview a single page as well as the whole project.
ESD employs the EVE emulator to render an EVE display onto the layout editor. It
provides users, the interface to view the result of the screen design and its logic.

The following file types are displayed in ESD layout editor:

e Application logic file - generally with “.main” extension
e Page file - generally with “.page” extension

Page stands for a single screen which will be rendered. One application consists of at
least one page. Page may have its own life cycle and manages all the widgets on it. Only
widgets can be dragged and dropped into pages at Page layout editor. However, all the
nodes from a library can be dragged and dropped into the logic node editor.

“Active” Property

The “Active” property is a Boolean value to control the page, and is created or released
while the application is updating the pages. By default, the “Active” property is True. The
page is created and shown, unless “Switch” end is connected.
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Switch Page

Users can define multiple pages within the project. "Switch
Page” ESD layout should add to manage the pages. User
can drag and drop the pages into this switch page from
project browser. The picture below displays how the logic
editor view looks like for the switch page logic.

AlarmManager.actor
AlarmManager.c
AlarmPage.c
AlarmPage.page

Eenen I i i =

nnections

mPage
ymMenu

ClockPage.page
B HalfPulselogic
B setPagec
B setPage.page

Figure 55 - Switch Page

App.main 7 AlarmPage.c AppScreen.page®

SystemPaage
ClockPage

Pointer

O
O

Painter

iger

AlarmManager

BottomMenu

Faointer

Width
Height

SetPage

Painter
O Activate O
[ Destroy O
TimeManager
Active
X
¥
Width
Height

Width
Height

Figure 56 - Sample Switch Page UI

Page Persistence

To allow a page to remain in memory with its current state even when it is made
inactive, set the allocation mode to “Lazy Persistent” or “Static” from the application
logic in the page's Properties. This feature can help users to reserve the information of a
page even when it is not visible.
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WHSOR ~ | FT90x F | FTo00 One-wire

chig 4 » U
»

120 160~

Value

Width
Height

Figure 57 - Propertles Editor - Page Allocation

The page allocation modes supported in ESD are listed in the table given below:

Allocation Mode Description

Static Page is always persistent in memory after application starts

Lazy Page is created when it is in “active” state and destroyed when it is
inactive

Lazy Persistent Page is created when it is in “active” state but persistent in memory when

it is “inactive” until application is closed.

User Defined Function for Page File

Users can write their own code to handle the “Pushed” signal of the “ESD Push Button”
widget. Users are required to select the “ESD Push Button” widget in the logic node
editor and double click it. A function will be generated to replace the user defined
function.

ESD METHOD (MainPage ESD Push Button Pushed, Context = MainPage)
void MainPage ESD Push Button Pushed(MainPage *context)
{

// Users can write their code here

The code can be located at $(PageFileName).c file.

MainPage.page® ** App.main MainPage.c ™

= MainPa

Figure 58 - Sample Source File
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Zoom In & Out

The visual area of the screen layout editor can be zoomed when the current file is a page
file, i.e., "“.page” file. The mouse wheel button provides zoom-in and zoom-out
functionality, allowing users to view more details about the screen design. Refer to the
sample picture given below:

4IOO 4;0 4T’l0 4ISD 4§D spo SIZG 5‘40 S:E-G 5?!0 -

Figure 59 - Zoom In & Out

To view the application logic file (*.main) file, double click the file within the project
explorer. The screen layout editor will show the first page defined in the logic node
editor. To view how the application logic is defined, click the “Simulation” button and
check it in the screen layout editor.

File Edit Build Tools WView Help

812A WH50R = FT90x Release P FT900 One-Wire ~

App.main 7 MainPage.c
outs

S outs
E S D SD Render Functions
S ilities
App Scre S

& Logic Flow
- c Interface

! MainPage.c
g

Width
B Mainage page ACle et Heigh:
B testtheme

Value
Error List (53 Output App.main
® 0Erors A\ 0Wamings @ 0 Messages Clear Simulation

Default Signal
Icon

Inspector Error List

BITMAP_HANDLE: 0 RAM_DL: - +* C compilation | 100% ™ Render

Figure 60 - Main File
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Logic File ‘

The logic file contains certain logic that is used to encapsulate the user defined logic. It
works similar to a C function. A logic file does not render any user interface.

Set Variable

EEEEET

37

Set Variable

jfalfas -~ - Oafad--sEEa@e@-~ -~ -

Figure 61 - Sample Logic File

The screen layout editor provides a simple C editor when users double click a “.c” file in
the project browser. Note that it is not a full-fledged C editor and many features may be
implemented in the future.

File Edit Build Tool
Ba B &, :DC ' 2 Li : FTS00 One-Wire ~

Project App.main Ft_Esd_ColorPicker.c
-

Simple C
Editor

DisplayName = '

PARAMETER
PARAMETER
PARAMETER
PARAMETER (v1,

) PARAMETER (r, Type =

Figure 62 - C File / C Editor

~ '~ To effect the changes made, ensure that all the changes are saved to the project by
clicking “File — Save All” from the menu or from the toolbar.
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Logic Note Editor |

Using the Logic Node Editor (LNE), users compose screen logic by connecting logic
nodes. The Logic Note Editor is designed to open the following file formats:

Application logic file , *.main file
Screen logic file, *.page file
Widget file, *.widget

Actor file, *.actor

User defined logic file, *.logic file

Basic Logic Node

ESD has some built-in predefined basic logic nodes. These basic logic nodes provide
basic control flow and logic interfaces as well as basic functions. A typical basic logic
node is represented in the logic node editor as below, the name of which is shown in
white.

Ft_Esd_DI_COLOR_ARGB

|
Color

Figure 63 - Logic Node Editor - Basic Logic Node

Within the library browser, the basic logic nodes are located at “"Logic Flow”, “Logic
Interface”, "ESD Utilities” and "EVE Render Functions”.

File Edit Build Tools View Help
i a = & & C ' ) ® i elease % FT200 One-Wire

Project & ) . - o Library

=1

* [ BasicMath.esd

»
»
»
-

nnections

m
m

m
o n

& | App5creen.page
2 | MainPage.page

i1

) PARBMETER (v1,
ESD PARBMETER(r, Typ

i

Figure 64 - Library Browser - Basic Logic Nodes

Composite Logic Node ‘

A Composite Logic Node is made up by connecting multiple basic logic nodes. A typical
composite logic node is defined in a standalone document in XML format and is shown in
the logic node. Refer to the picture given below -

Product Page 67
Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.7

BRIDGING TECHNOLOGY Version 1.7

Y .
< Brldgetek BRT_AN_029 EVE Screen Designer 4.18 User Guide
0.‘

*

Document Reference No.: BRT_000218 Clearance No.: BRT#159
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Theme
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Font
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Figure 65 - Composite Logic Node

The following are the different types of composite logic nodes defined in ESD 4.14:

Page Node
Widget Node
Layout Widget
Actor Node
Logic Object

Page Node

When users create a single page, it is represented by a logic node under the “User Page”
category in the library browser. Users can connect one page node to another within the
logic node editor. It has its own property and defined output.

App5Screen
Pointer

O
O

Width
Height

Figure 66 - Composite Logic Node - Page Node

Widget Node

The Widget Node is one type of logic node which has visual appearance and is able to
handle user input. It has the built-in Start, Update, Idle, Render and End slots.

For more information on built-in slots, please refer to Built-in Slot.
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Within the logic node editor, the widget name is highlighted with the colour title as

shown in the sample picture below -

File Edit Build Te

A= &

Theme
Alpha
Hours
Minutes
Seconds
Miilseconds
Interective
Active
X
3
Width
Height

> AutoResize

® OErors A OW

%

134

164
Ft_Esd_Theme_
255

r | Error List

Figure 67 - Logic Node Editor — Widget Node

The highlighted sections provide information on adding user widgets; the position and
size properties; rendering the widget and widget theme.

Adding User Widgets

File Edit Build Tools View Help
MNew P B Logic
! Add W Actor

A User Widget, also called as custom
widget is a reusable user interface

element created by a user. To create
a widget, from the menu, click and
select “"File > New > Widget".

[ M Save
Close
= Save All
MNew Project

Open Project

M widget

M Page

“& Theme

B Source Files

B Logic Source Files

In order to make use of these slots, users need to drag the slots from the library
browser and drop them into the logic node editor. By renaming it to the slot defined
above, users can connect widget control flow to application control flow.

Position & Size Properties

As a user interface element, widgets have at least position and size properties so that
users can control them using a visible handle. Position property is defined by an “Input”
node with “ft_int16_t" type named as “X” or “Y”. Size property is defined by an “Input”
node with “ft_int16_t” type named as “Width” or “Height”. Figure 68 provides a sample
of the “X” property.
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Froperties

Property Value

(Input)

MName X

Display Name

Comment

Type ft_intl6_t
Edit Role

Min

Max

Single Step

Default

Figure 68 - User Widget - Position & Size Properties

Rendering a widget

Rendering of a widget may be implemented fully in the logic editor, or directly in the
code using the logic editor to glue together the code with the generated structures. To
create the render function, simply add a Slot from the Logic Interface category of the
library browser, name it “Render” and double click to create the user method for
handling the rendering. The widget is expected to restore any graphics state it changes,
with the exception of the state values specified below.

Preferably use the Ft_Esd_DI_ utility functions for display list drawing when available.
Several state parameters which may be expected to be changed often to the same value
implement de-duplication here to shorten the display list. The de-duplicated values
are: Palette source, Color RGB, Color A, Handle, Cell, and Vertex Format. These graphic
state values are not required to be restored to their original values when the Ft_Esd_DI_
functions are used. These values should be expected to be any undefined value at the
start of the Rendering function. Access the value of the X input property as given below:

int x = context->X(context->Owner) ;

This calls the get () function assigned by the parent to the X property, passing the
owner’s context to the function to handle it there.

Theme

Widgets should provide property input to override the default application theme. An
input property with type Ft_Esd Theme * should be added by dragging one input node
from the “Logic Interface” category of the library browser. Colours from the theme may
be accessed from the logic editor using the utility functions under the ESD Theme
category, or from the user code as given below:

Ft Esd Theme *theme = context->Theme (context->Owner) ;
if (theme == NULL) theme = Ft Esd Theme GetCurrent();
ft rgb32 t primaryColor = theme->PrimaryColor;

Touch Input

In order to handle the touch input, add a Touch Tag node from “"ESD Utilities” category
of the library browser to the logic editor, and either handle the signals or access its state
through the Touch Tag interface. Users need to make use of the “Tag” value provided
by the “Touch Tag” node during the Render function, and restore the “Tag” to value 0
after the relevant portion of the rendering.
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To handle any of the signals from Touch Tag in user code, simply create an
ESD_METHOD style function in the same format as the Render user code function, and it
will be available from the User Functions category in the library to drag into the logic
editor and connect to any of the signals from the Touch Tag node.

Layout Type Widget

Layout widget is a layout container for widgets. Unlike widget nodes which have visual
appearance, a layout widget manages the layout specification for its child widgets.
Layout widgets are introduced since ESD 4.0. Figure 69 & Figure 70 displays the various
layout widgets supported in ESD.

Library
| ESD Layouts

= Lo gic Flow
B LogicInterface
i ser Actors

2]
2]
2]
a
r B
a
2]

cCCcCcCcCCo
I A A A A
] ]

App.main® Ft_Esd_C cker.c ™7

Fill Layout Fixed Positioning Linear Lavout Scroll Lavout

Pointer Pointer Painter Pointer

Width Width Wic Width
Height Height Height

Stretch Switch Page
Pointer Pointer
Scrollx
Scrolly
Align
Scissor
RangeX
RangeY
Width
Height
Scroll . hanged
Scroll.. hanged

Figure 70 - Layout Widgets

Actor Node

Actor type is an extended type of logic node which functions similar to the widget node,
but without the Render slot. Therefore, it has no visual appearance. When users create a
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new actor node, it does not show in the layout editor. It has the built-in Start, Update,
Idle and End slots which are not available in a regular logic node. For more information
about built-in slots, please refer to Built-in Slot.

An Actor node is useful for implementing both continuous and background running
behaviours, such as animations, timers, and input data polling. The actor node name is
highlighted with the yellow colour within the logic node editor.

SlideBackward

Active
Ml Play
Value

Figure 71 - Actor Node

To create an actor, from the menu, click and select “File > New > Actor”.

File Edit Build Tools View Help
Mew > B Logic
B Add B Actor
- BN Widget
se B Page

= Save All B Theme

New Project Source Files

Open Project B Logic Source Files

= " ¥ Refer to the example project “ActorAnimator.esd” under the “EVE Screen
Designer — Examples — Basic — ActorAnimators” folder for adding and using
actor node.

Logic Object

A Logic Object is a basic logic block designed to express certain logic which has NO built-
in slot. Hence, it is not possible to invoke it through the built-in render slot or update
slot. However, it may have its own private or public property and output, signal and slot,
depending on the users’ implementation.

A logic object is generally used to simplify complex logic by splitting it into multiple
smaller and simpler logic objects. It is defined and saved in a “*.logic” file.

Within the logic node editor, the logic object hame is highlighted with the grey colour.

Switch Bitmap Cell
Bitmep Cell

Cell

Figure 72 - Logic Object

To add a logic object, from the menu, click and select “File > New - Logic”.
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Connections \

Connections are lines between two nodes. The connection line’s colour is determined by
the ends. The following table provides the different types of ends and their description.

Connection Line End Type Description
. ﬁ Event slots and signals are implemented as functions which only

Event slots and Signals take a pointer to the node context as a parameter. The node
context contains the state of the node as well as a pointer to the
parent node to signal back.

L . Data property input and output bindings are implemented as get-

Data property bindings functions which only take a pointer to the node context as a

/ / parameter and return a value. This means that these connections
are completely evaluated every time the property is read, and

consequently the property always reads as the latest value. A

buffer variable can be used to cache values if necessary. The

different colours denote the different data types.

Variable write The write interface is translated into a function pointer during the
code generation. Variables are plain variables, which can be
written using the Set Variable node. They may also be set through
the Writer interface which is implemented using a pointer to a set-
function.

Table 9 - Connection End Types

In general, all of the input properties that can be connected can also be specified from
the property editor when they are constant values; this is sometimes referred to as the
“Default” value. In addition, it is possible to specify the Minimum and Maximum values
for the input bindings and variables.

Rendering Order \

In the application logic file “"App.main”, the pages added on MainPage
the logic node editor are to be represented with the symbols Painter
shown in the sample picture.

O
O

When there are more than two pages, the order in which the
pages were created determines the rendering order.

Width
The following implicit rule of the logic node editor is worthy to Height
be noted, since this rule applies to all the logic nodes.

“"Depth Sort” is used to determine the rendering order of the logic nodes. The
greater the value of “"Depth Sort”, the later the logic node is rendered and higher
the layer in which it is shown. When logic nodes have the same “Depth Sort”
value, the logic node’s “X"”/ “Y"” coordinate (within layout widget) determines the
rendering order. The page node with the lowest value of the “X"”/ “Y” coordinate
is rendered first (as lower depth value).
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ToggleMainPage

Main Page

The Logic Node Editor enables Zoom-in and Zoom-out functionality. Users can make use
of the mouse wheel button to zoom in and zoom out.

“Panning” the logic node editor screen helps reveals the parts of the logic node editor
which could not have been fit in a single screen. Panning can be done by 2 ways:

(i) Press Alt Key + Left mouse button and move the mouse
(i) Press the middle mouse button and move the mouse.

User can select multiple node items in the logic node editor by pressing Control key and
selecting the desired objects by left mouse button click. Single/multiple objects can thus
be moved if needed by moving the mouse while pressing the Left mouse button.
Avoid two connections connecting to the same port. Refer to the sample
picture given below.

Active
Theme
Font
Tendt

x v

Width

DON’TS

O aligny

Unary Operator

Value Result
Variable

Avoid endless dead loops caused by connecting the input and output of the
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same object. It will cause an unexpected error. Refer to the sample
pictures given below.

Set Variable

Active
Theme
Font
Text

Ternary Operator

P e o I
TR ==

Waiue It Trus Y
Value If False Width
Height
Alignx
2 AlignY

~ w4 To effect the changes made to the logic note editor, ensure that all the changes
are saved to the project, by clicking “File = Save All” from the menu or toolbar.

In some cases, click the “Recompile” ﬂ button to recompile the source code
generated by ESD.

Library Browser

Library
]

The Library Browser consists of the basic components
which are predefined and built in as part of ESD 4.14,
as well as user defined components and/or resources.
The components in the library include Theme, Primitive,
Widgets, Logic Flow and Logic Interface. Users can :

. . Legic Flow
select the appropriate components and drag them into & Logic Interface
the logic node editor or layout editor. ser Actors

ESD Layouts

ESD Render Functions
ESD Theme

ESD Utilities

ESD Widgets

] 5| | |

The library view depends on the currently selected
node. The library browser will only show the contents
which applies to the currently opened node.

Figure 74 - Library Browser
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In the Library Browser, items can be filtered by entering the search text in the textbox.
Regular expression is supported. The matching text is highlighted as shown in the
sample picture given below -

Library

pol|gra

=

- 5D Render Functions
F Elements
[ | Ft_EE-I:l_E|El'r'lEr‘ItE-_.I:liEr‘lt_F'El‘IEl
B Primitives

BN EsD Multi Biddient
. ESD Multi dient (Rounded)

. ESD dient Rectangle (Fixed Point)
g

dient Rectangle (Integer)

B tso

Figure 75 - Library Filter

The forthcoming sections provide information about the different components of the
library browser.

ESD Layouts |

ESD Layouts contains the collection of ESD layout widgets and &kl
layout utilities functions.

EV Language Resource

tch Widget

amic Switch Page

Scroll Layout
retch
Switch Page
Scroll Switch Page
. Signal Switch Page

Layout Description
Dynamic Switch Page | This Layout is used to achieve a fade-in/fade-out animation from one
page to another page

Fill Layout This layout is used to fill up the whole widget display region

Fixed Positioning This layout is for fixed coordinate layouts

Linear Layout This layout supports both horizontal and vertical layouts

Scroll Layout Specific layout for scrollable panel

Stretch This layout supports both horizontal and vertical layouts

Switch Page To manage page switching logic
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Scroll Switch Page This layout supports scroll between pages according to the swipe

direction.
This layout support switch between pages via signals, can be set as
vertical switch or horizontal switch.

Signal Switch Page
There are also layout utilities and advanced layout features provided in ESD Layouts
collection. These sections are for advanced user only.

Layout utilities are a set of helping functions to ease the development of layout. Users

can build their own layout widget by making use of them. There are several items
defined for sorting widget’s purpose.

Utilities

ESD provides various Layout utility functions while

designing layouts.

c

tilities

Get Horizontal Align
Get Vertical Align
Detach

Get Global Height
Get Global Width
Get Global X

Get Global ¥
Insert Above
Insert Below
Insert at Bottom
Insert at Top

Is Bottom

Is Top

Is Visible

Sort Higher

Sort Lower

Sort to Bottom
Sort to Top

Get Horizontal Align

The Get Horizontal Align utility is used to align the widget

horizontally.

The function can be called as shown below:

ESD FUNCTION (ESD ALIGN HORIZONTAL,

Get Horizontal Align

) align

Type = Esd AlignHorizontal, DisplayName

= "Get Horizontal Align", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (align, Type = Esd Align)

#define ESD ALIGN HORIZONTAL (align)

(align & 3)

Get Vertical Align

The Get Vertical Align utility is used to align the widget

vertically.

The function can be called like below:

Get Vertical Align

O align

ESD FUNCTION(ESD ALIGN VERTICAL, Type = Esd AlignVertical, DisplayName =
"Get Vertical Align", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (align, Type = Esd Align)

#define ESD ALIGN VERTICAL (align) (align & 12)
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Detach

The Detach utility is used to detach the widget from the Detach
current parent layout O] cal

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget Detach, DisplayName = "Detach", Category =
EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget Detach (Ft Esd Widget *context);

Get Global Height

The Get Global Height utility is used to get the global X co- Get Global Height
ordinate of widget. context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalHeight, Type = ft intl6 t, DisplayName
= "Get Global Height", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalHeight (context) (((Ft Esd Widget *)context)-
>GlobalHeight)

Get Global Width

The Get Global Width utility is used to get the width of Get Global Width
the widget. context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalWidth, Type = ft intl6 t, DisplayName =
"Get Global Width", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalWidth (context) (((Ft Esd Widget *)context)-
>GlobalWidth)

Get Global X

The Get Global X utility is used to get the global X co- Get Global X
ordinate of the widget.

context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalX, Type = ft intl6 t, DisplayName =
"Get Global X", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalX(context) (((Ft Esd Widget *)context)-
>GlobalX)
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Get Global Y

The Get Global Y utility is used to get the global Y co- Get Global Y
ordinate of the widget. CRERE

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalY, Type = ft intlé6 t, DisplayName =
"Get Global Y", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalY (context) (((Ft Esd Widget *)context)-
>GlobalY)

Insert Above

The Insert at Above utility is used to insert a widget Tnsert Above
above the specified sibling widgets in the sibling widgets = Ca(';

Widget
parent layout. Sibing
ESD FUNCTION (Ft Esd Widget InsertAbove, DisplayName = "Insert Above",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (sibling, DisplayName = "Sibling", Type = Ft Esd Widget *)

void Ft Esd Widget InsertAbove (Ft Esd Widget *context, Ft Esd Widget
*sibling) ;

Insert Below

The Insert at Below utility is used to insert a widget AL Kckonn:

below the specified sibling widgets in the sibling [

widgets parent layout. Widget
Sibling

The function can be called like below:

ESD FUNCTION (Ft Esd Widget InsertBelow, DisplayName = "Insert Below",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (sibling, DisplayName = "Sibling", Type = Ft Esd Widget *)

void Ft Esd Widget InsertBelow(Ft Esd Widget *context, Ft Esd Widget
*sibling) ;

Insert at Bottom

The Insert at Bottom utility is used to insert a widget AEEEEL O S

in the bottom position of the specified parent layout. Ll call

Widget
Parent

The function can be called like below:

ESD FUNCTION (Ft Esd Widget InsertBottom, DisplayName = "Insert at Bottom",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget ¥*)

ESD PARAMETER (parent, DisplayName = "Parent", Type = Ft Esd Widget *)

void Ft Esd Widget InsertBottom(Ft Esd Widget *context, Ft Esd Widget
*parent) ;
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Insert at Top

The Insert at Top utility is used to insert a widget in Insert at Top
the top position of the specified parent layout. [ call

Widget
The function can be called like below: Parent
ESD FUNCTION (Ft Esd Widget InsertTop, DisplayName = "Insert at Top",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (parent, DisplayName = "Parent", Type = Ft Esd Widget *)

void Ft Esd Widget InsertTop (Ft Esd Widget *context, Ft Esd Widget *parent);

Is Bottom

The Is Bottom utility returns FT_TRUE if the widget is Is Bottom
the bottom widget within the current parent layout.

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsBottom, Type = ft bool t, DisplayName = "Is
Bottom", Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ft bool t Ft Esd Widget IsBottom(Ft Esd Widget *context);

This Is Top utility returns FT_TRUE if the widget is the
topmost widget within the current parent layout Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsTop, Type = ft bool t, DisplayName = "Is Top",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ft bool t Ft Esd Widget IsTop(Ft Esd Widget *context);

Is Visible

The Is Visible utility is used to check if the widget is Is Visible

within the current screen scissor area.
context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsVisible, Type = ft bool + t, DisplayName = "Is
Visible", Category = EsdLayoutUtilities)

ESD PARAMETER (context, Type = Ft Esd Widget ¥*)

ft bool t Ft Esd Widget IsVisible(Ft Esd Widget *context);

Sort Higher ‘

The Sort Higher utility is used to sort the widget Sort Higher
above its current sibling within the current parent
layout.

] call
Widget
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The function can be called like below:

ESD FUNCTION (Ft Esd Widget SortHigher, DisplayName = "Sort Higher",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortHigher (Ft Esd Widget *context);

Sort Lower

The Sort Lower utility is used to sort the widget below
its current sibling within the current parent layout.

[ call
The function can be called like below: Widget
ESD FUNCTION (Ft Esd Widget SortLower, DisplayName = "Sort Lower", Category
= EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortLower (Ft Esd Widget *context);

Sort to Bottom

The Sort to Bottom utility is used to sort the widget to Sort to Bottom
the bottom within the current parent layout. O call
Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget SortToBottom, DisplayName = "Sort to Bottom",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortToBottom(Ft Esd Widget *context);

Sort to Top

The Sort to Top utility is used to sort the widget to the
top within the current parent layout. O call

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget SortToTop, DisplayName = "Sort to Top", Category
= EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortToTop (Ft Esd Widget *context);

Switch Page

The Switch Page is a special layout which focuses on page/widget transitions. By default,
there will be only one Switch Page layout in “AppScreen.Page” in every ESD project.
However, this is optional and the users can remove or change the switch page layout in
the project. Refer to the example project "EVE Screen Designer > Examples > Basic
-> MenuPage > MenuPage.esd > AppScreen.page” for a switch page demo.
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Library
v B EsD Layouts
b F Advanced
P I Utilities
|_j Fill Layout
= Fixed Po Width
I LinearLa Height
B Scroll Layout Spinner
Stretch Scissor
i Switch Pa AutoResize
Property Name Description
Pointer The pointer reference of the widget object
Active Enable or disable displaying this widget
X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width
Height Widget Height
Spinner Set true to show spinner/loading icon when switching page. This is useful
user indication when a page has heavy resource.
Scissor Set true, to trim off any content is drawn outside the layout region.
Auto Resize Set true, to enable auto resize for this layout.

Table 10 - Switch Page Layout Properties

Switch Page Implementation N
== App.main
* [ AppScreen.page
1. Set page/widget into Switch Page Actors
< Connections
Unlike widgets, Switch Page cannot be dragged on Screen L
Layout Editor or Logic Editor. In order to put a page under v Il Widgets
. ¥ @ Switch Page
the control of the switch page layout, the user has to use Al UserPage
. . . . . i UserPage
Project Browser instead, drag the widget into the switch B Main Page
page layout. ‘B DefaultTheme.theme

2. Page Resource

Value

Since ESD 4.0, a page resource allocation can be:

(UserPage)
. Mame Static
e Static — always load at the start Allocation Lazy
e Lazy - allocate when it is active, and free it when it is Depth Sort Lazy Persistent

inactive. Active
e Lazy persistent - allocate when it is first time active,
and it will remain in system until reset.

When a new page is activated, its parent object, the
Switch Page will also mark the current page as inactive and free it from memory when it
has “Lazy” mode of allocation.
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Dynamic Switch Page

The Dynamic Switch Page is a special layout which focuses on page/widget transitions.
The primary purpose of this widget is to achieve a fade-in/fade-out animation while
transiting from one page to another page. Like Switch Page widget, only one of the
children of Switch Page would be visible at any point of time. But unlike Switch Page
widget which abruptly changes the visibility between the transiting pages, Dynamic
Switch Page widget will fade-in and fade-out the new to-be-visible page and old not-to-
visible page.

Library

Dynamic Switch Page

Pointer
Active
| Dynamic Sw X
Fill Layout Y
Width
Height
AutoResize
B oot Suin bage Animation D...
Property Name Description
Pointer The pointer reference of the widget object
Active Enable or disable displaying this widget
X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width
Height Widget Height
Auto Resize Set true, to enable auto resize for this layout. -
Animation Duration Sets the time within which the animation needs to be finished.

Table 11 - Dynamic Switch Page Layout Properties

Dynamic Switch Page Implementation
b :; App.main

1. Set page/widget into Dynamic Switch Page - & ";FF‘S”EE"-PEQE

Unlike widgets, Dynamic Switch Page cannot be dragged
on Screen Layout Editor or Logic Editor. In order to put a
page under the control of the switch page layout, the user
has to use Project Browser instead, drag the widget into
the Dynamic switch page layout.

2. Page Resource Value

Since ESD 4.0, a page resource allocation can be: e i

Allocation Lazy

Depth Sort

Static - always load at the start
Lazy - allocate when it is active, and free it when it is
inactive.

e Lazy persistent - allocate when it is first time active,
and it will remain in system until reset.

Lazy Persistent
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When a new page is activated, its parent object, the Dynamic Switch Page will also mark
the current page as inactive and free it from memory when it has “Lazy” mode of
allocation.

Auto Switch Widget |

The Auto Switch Widget is a [kl B Auto Switch Widget
layout which focuses on rapid

. . . Pointer
transitions between its child Active
widgets. The primary purpose ' Utiities X
of this widget is to rapidly @ Auto Switch Widget y
activate its child widget one ) Dynamic Switch Page Width
by one in the order of its 3 _ Height

depth. The rate of change is mo ' Animation F...
set by the user. This can be
used to generate a gif like
animation effect. A sub. But
unlike Switch Page and
Dynamic Switch Page, the
transition between child widget is automatlc and not triggered. Use case of the widget
can be found in Examples/Basic/AutoSwitchLayout.

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinates of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Animation Frequency Sets the rate of change of child widget activations

Table 12 - Auto Switch Page Layout Properties

Auto Switch Page Implementation == Appman

1. Set widgets into Dynamic Switch Page

Auto Switch widget can be dragged on Logic Editor. In order
to put a widget under the control of the switch page layout,
the user has to use Project Browser instead, drag the widget
into the Auto Switch Widget layout.

2. Widget Rendering order

All child widgets are activated one by one and rendered in a sequence according to their
depth orders. Thus, to rearrange the order of activation, user needs to update the depth
order of the children widgets.

Fixed Positioning

The Fixed Positioning is a layout widget which allows its child widgets to be fixed at
design time. By default, every page starts with one fixed positioning layout, such that all
widgets under the page are placed at design time. Fixed Positioning layout does not
update its child widget’'s dimensions on runtime. Users should get what they see on
design time, on runtime as well.
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e= App.main F EsD Layouts
B AppScreen.page B Advanced
‘B DefaultThemetheme Litilities
B FirstPage.page Fill Layout

& Actors Fixed Positioning

<= Connections Linear Layout

m Modes Scroll Layout
v W Widgets Stretch

: P ¥ Fixed Position Switch Page

Fixed Position

]
k

Pointer

-

|
2 | |l|

=] &

L]

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Table 13 - Fixed Positioning Layout Properties

Fixed Positioning Implementation

- ., =
== App.main

B aAppScreen.page
‘B DefaultTheme.theme
~ B Firs tF'a;r.: page

)
1. Set page/widget into Fixed Positioning Layout 3
Drag and drop a new widget into the Screen Layout Editor
will be the highest depth sort widget in the layout by
default. However, the depth sort values are configurable
by the users. If a widget is not in fixed positioning layout,
the Screen layout editor will not able to change it is
position as it desired. Always check on project browser as
picture on the right.

2. Change Child Widgets’ depth sort

o UserWidget1

Changing the depth sort value of child widgets will affect their rendering sequence. This
functionality is same as in ESD 3.0.

Fill Layout ‘

ESD Layouts
B Advanced
| Utilities
Fill Layout
7 Fixed Positioning

The Fill Layout is the base
layout for every
widget/page since in ESD.
A widget always comes
with a Fill Layout in it.
However, a fill layout in a
page has a fixed size due

Fll Layout
Pointer

Linear Layout
Scroll Layout
. . Stretch

to the screen size defined Switch Page

from the hardware. All :
widgets in the Fill Layout will auto resize to fit the whole layout area.
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Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Table 14 - Fill Layout Properties

Fill Layout Implementation

Widgets
1. Change Widget sequence ~ IN Fill Layout
& ESD Clock
The fill layout sequence is ordered in the sequence of B ESD Image

widgets’ depth sort. Changing a particular widget to a
higher depth sort value, will increase the priority
widget’s rendering. The example below shows a clock
widget and an image widget under the same Fill
Layout. Both widgets are filling up the full “Fill Layout”
area. However, by setting the depth value of clock
widget bigger than the image widget’s depth sort, the
clock widget will be rendered on top of the image
widget.

Linear Layout
The Linear Layout supports | ESD Layouts Linear Lavout
both horizontal and vertical Advanced Pointer
alignment in ESD. All child Utilities
widgets will be distributed in el
the selected orientation. E!:':E_'j Positioning Width
inear Layout Height

Users cannot change the eI Margin
sequence of widgets in the Stretch Spacing
linear layout from Screen @ Switch Page St
Layout Editor in ESD. i Overflow
However, changing their depth sort value i;‘:jgippmg
from the property browser will change the sequence. < AutoResize

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels

Y Y coordinate of the top-left of the widget, in pixels

Width Widget width

Height Widget Height

Spacing Set the spacing gap between adjacent child widgets.

Orientation Set Linear Layout orientation. It supports:

e ESD_ORIENTATION_HORIZONTAL

e ESD_ORIENTATION_VERTICAL
Alignment Set the alignment setting for the child widgets in the layout
Overflow Set child widget overflow mode. It supports:

e ESD_OVERFLOW_ALLOW

e ESD_OVERFLOW_CLIP

e ESD_OVERFLOW_FILL
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Scissor Set true to enable scissor to clip off overflow
ChildClipping Set the flags when child clipping should check. It supports:
e ESD_CLIP_RENDER
e ESD_CLIP_UPDATE
e ESD_CLIP_IDLE
Auto Resize Set auto resize mode for this layout.
Table 15 - Linear Layout Properties

Linear Layout Implementation

1. Horizontal Layout

All  child widgets of a linear layout with its orientation are set to
“ESD_ORIENTATION_HORIZONTAL"”. They will be distributed horizontally with some
spacing in between adjacent widgets. The layout used as in the example here has

parameters:

Orientation = ESD_ORIENTATION_HORIZONTAL
Spacing = 4

Align = ESD_ALIGN_TOPFILL

Overflow = ESD_OVERFLOW_ALLOW

= B UserWidg

i

2. Vertical Layout

All child widgets of a linear layout with its orientation set to
“ESD_ORIENTATION_VERTICAL". They will be distributed vertically
with some spacing in between adjacent widgets. The layout used as
in the example here has parameters:

Orientation = ESD_ORIENTATION_VERTICAL

[ )

e Spacing =4

e Align = ESD_ALIGN_TOPFILL

e Overflow BN~ [ Userwidgetlwidget
ESD_OVERFLOW_ALLOW @ Actors

<2 Connections
= MNodes

+ W Widgets

* M Linear Layout
@ ESD Clock 4
@ ESD Clock 3

87
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Stretch

The  Stretch Layout is D Layouts

u ES Stretch
designed to work together b I Advanced .
; . = e Pointer

with the linear layout. In the b B Utilities
event some widgets need to % Fill Layout
have higher weightage in the = Fixed Positioning
layout, Stretch Layouts are lI Linear Layout Width
used. ! Scroll Layout :

Stretch Height

® Switch Page Weight
Property Name Description
Pointer The pointer reference of the widget object
Active Enable or disable displaying this widget
X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width
Height Widget Height
Weight The weight factor when determine the stretch scale in the

selected orientation
Table 16 - Stretch Layout Properties

Stretch Layout Implementation

1. Space Stretching

The example here demonstrates how to stretch unused space horizontally. A stretch
layout has been added into the Linear Layout. The weight factor used here is 1.

* I Linear Layout

[ Stretch

& ESD Clock

2. Widget Weight Stretching
The example here demonstrates widget stretching. In this example, every clock widget

has different stretch weight values. The result every widget gains their proportion of
width as shown below -

Weight: 1

Stretch 2

© ESD Clock3
Stretch

© ESD Clock 4
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Property Name
Pointer

Active

X

Y

Width

Height

ScrollX
ScrollY

Align
Scrollbars
TouchScroll
Scroll Bar Size

50 Layouts ScrollPanel

Advanced Pointer

Uilities

Fill Layout
- Fixed Positi .

. Width
Linear Layo Height
Scroll Layout ScroliX
C i ScrollY
Stretch :

. Align
Switch Page > ScrollBars

TouchScroll
Scroll Bar Size

MinX

MaxX

MinY

MaxY

RangeX
RangeY

Width

Height

Scroll.. hanged
Scroll.. hanged

Description
The pointer reference of the widget object
Enable or disable displaying this widget
X coordinate of the top-left of the widget, in pixels
Y coordinate of the top-left of the widget, in pixels
Widget width
Widget Height
Getter and Setter for scroll value along X-axis
Getter and Setter for scroll value along Y-axis
Set alignment for its child widgets
Set when scrollbar should be visible
Set true to enable touch scroll
To set scroll bar size when it is visible
Table 17 - Scroll Layout Properties

Scroll Layout Implementation

For the implementation of scroll layout, refer to the example project - “"EVE Screen

Designer > Examples > Intermediate > ScrollPanel.
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The Scroll Switch Page Layout
consists of a switch page manager
and a scroll panel for runtime
scrollable support.

Scroll Switch Page layout requires 3
lazy page instances and a current
index to start with, namely - the
previous page instance, the current
page instance and the next page
instance.

Upon user touch swipe event, the
page will switch according to the
swipe direction. The behaviour of this
scroll switch page layout is as below:

e On non-swiping runtime, it only
renders the current page, but

runs the update logic of all the 3 pages.

Scroll Layout
tretch
Switch Page

i Scroll Switch Page

ESD Scroll Switch Page

Pointer

[ Initialise ]

NewPage []
Initial Previ...
Initial Current
Initial Next
Initial Index
Active Scroll
Spinner
New Page
Active
X
) f
Width
Height
Loop Pages
Count
Spacing
Sensitivity
Switch Speed

Previous Page
Current Page
Next Page
Current Index
New Index

Figure 76 - Scroll Switch Page Layout

e On swiping event, it displays both the current page and the swiping to page (can be
previous and next page instance).

e On touch up event, it will either recover to the original position if the swiped range
has not reached the minimum threshold or switch to the new page. The touch scroll
will be temporally disabled until it has recovered or switched to the target page.

e Upon switching page complete, the scroll switch page will fire "NewPage” event and
requests a new page instance to be allocated and assigns it as the "New Page” input.

Property Name
Pointer

Initialise

Initial Previous
Initial Current
Initial Next
Initial Index
Active Scroll

Spinner

New Page
Active

X

Y

Width

Height

Loop Pages
Count
Spacing
Sensitivity
Switch Speed
Previous Page

Description

The pointer reference of the widget object

The “initialise” slot for initialling the scroll switch page layout
Initial Previous page instance at start

Initial Current page instance at start

Initial Next page instance at start

Initial Current page index at start

Set true to override child widgets touch tag event where tag is
default(255)

Set true to show spinner upon loading the new page instance.
New page instance input

Enable or disable displaying this widget

x coordinate of the top-left of the widget, in pixels

Y coordinate of the top-left of the widget, in pixels

Widget width

Widget Height

Set true to loop the pages

Set pages count/limit

Defines the spacing between pages

Define the scroll switch sensitivity, range from: 0.05 to 20.00
Define the switch speed during page transition

The output of previous page instance
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Current Page The output of current page instance
Next Page The output of next page instance
Current Index The output of current index

New Index The output of new index

Table 18 - Scroll Switch Page Layout Properties

Scroll Switch Page layout Implementation

In typical configuration for a scroll switch page layout, the figure below demonstrates a
sample setup. It should have the following rules:

e Connect start slot to the "Initialise” slot of scroll switch page layout instance.

e All switching pages should be configured as child widgets of Scroll Switch Page.

e All child page widgets should be lazy allocation and has same width as the Scroll
Switch Page.

e Initial Previous Page, Initial Current Page and the Initial Next Page should be
active by default while the rest of child pages should be inactive.

e Initial index should be the index of initial current page.

e Recommend using the “Switch” node to trigger the specific “Activate” signal of
the target page.

¢ Recommend using the “Switch Value” node to get the specific target page
instances from all the pages.

¢ Recommend adding header and footer pages which are Sibling widgets of the
Scroll Switch Page Layout instance.

5

nnections

B Page 1 Controls
B i | Page 2 Termnperature
= z m Page teld 'y

OMmN s Es

3
"

< | Page 3 Indicators
E! PageFooter

Figure 77 - Sample Scroll Switch Page Implementation
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Signal Switch Page Layout

The Signal Switch Page Layout is a
simplified layout of Scroll Switch Page
Layout which designed for the user
case which touch

supported.

| ESD Layouts Signal Switch Page

nced

[ NextPageSig...

[ PreviousPag...
. [ Initialise
screen is not
Initial Previ...
Initial Current
Initial Next

The same as Scroll Switch Page Layout, ine Initial Index

Signal Switch Page Layout requires 3
lazy page instances and a current index
to start with, namely - the previous
page instance,
instance and the next page instance.

2 slots, namely NextPageSignal and IR
PreviousPageSignal
the user to switch to next or previous

are provided for

Scroll Layout New Page

[ stretch Active

W Switch Page :

W Scroll Switch Page Width

™ signal Switch Page Height
Switch Speed
Count
Loop Pages

current page

Shifting
Previous Page
Current Index

Current Page

page. The signals to trigger the switch S
page can be a button trigger, or Next Page

another signals.

Figure 78 - Signal Switch Page Layout

Similar to Scroll Switch Page Layout, on swiping event (trigger by signal), it displays
both the current page and the swiping to page (can be previous and next page instance).

Property Name
Pointer
Initialise

Initial Previous
Initial Current
Initial Next
Initial Index
New Page
Active

X

Y

Width

Height

Loop Pages
Count

Spacing
Switch Speed
Previous Page
Current Page
Next Page
Current Index
New Index
Layout Direction
Shifting

Description

The pointer reference of the widget object

The “initialise” slot for initialling the scroll switch page layout
Initial Previous page instance at start

Initial Current page instance at start

Initial Next page instance at start

Initial Current page index at start

New page instance input

Enable or disable displaying this widget

x coordinate of the top-left of the widget, in pixels
Y coordinate of the top-left of the widget, in pixels
Widget width

Widget Height

Set true to loop the pages

Set pages count/limit

Defines the spacing between pages

Define the switch speed during page transition
The output of previous page instance

The output of current page instance

The output of next page instance

The output of current index

The output of new index

Choose between horizontally or vertically

Boolean value to show if page is in the middle of shifting or not

Table 19 - Signal Switch Page Layout Properties
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ESD Render Functions \

All render functions are non-widget. They are not W ESD Render Functions
managed by layout in ESD 4.14. Non-widget functions & Elemen

are to be used only within a widget. These functions are o -
provided as utilities for user to make their own custom » I Display List

widgets. ESD Theme

Note: In order to preview the render functions result in design time, render slot in the
custom widget is required.

Elements

| ESD Render Functions
The Elements are both simple and basic widgets, usually * B Elements
used to construct higher level and more complex widgets. B ESD Circle Flat
Normally, they do not handle any touch input.

rcle Sunken
B 5D Gradient Panel
B EsD Panel
B ESD Panel Raised

Figure 79 - ESD Elements

ESD Circle

The Circle element allows the user to
draw circles on the screen. The
following styles are available - ESD
Circle Flat; ESD Circle Raised and ESD

Circle Sunken. ¥
radius

Figure 80 - ESD Circle Element

Property Name Description

Color RGB value to be rendered inside the circle
X x coordinate of central point, in pixels

Y Y coordinate of central point, in pixels
radius Radius of the point

Table 20 - ESD Circle Element Properties

ESD Panel

The ESD Panel is an adjustable rectangular
widget that defines a coloured area. The iz
colour can be specified by a theme or user’s *
selection. Internally, it is constructed by EVE
primitives RECTS and SCISSORS. Two styles
of ESD Panel are available namely - ESD
Panel Raised and ESD Panel Sunken.

Figure 81 - ESD Panel Element
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Property Name

Description

Theme Theme to be applied on the panel

X x coordinate of the top-left point, in pixels

y Y coordinate of the top-left point, in pixels

width Panel width

height Panel Height

radius radius of the corners

raised Set to true to make panel in raised style
Table 21 - ESD Panel Element Properties

ESD Gradient Panel

The Gradient Panel element is an S _
adjustable rectangular widget that = e iEnt Panel
defines a gradient-coloured area. The Y

gradient colour can be specified by two height

colours (one at start and one at the radius

end). The gradient direction is adjustable colorl

color2
direction

by changing the direction.

Property Name

raised

Figure 82 - ESD Gradient Panel Element

Description

X X coordinate of the top-left point, in pixels

y Y coordinate of the top-left point, in pixels

width Panel width

height Panel Height

radius radius of the corners

colorl Start colour for gradient effect

color2 End colour for gradient effect

direction Gradient effect direction

raised Set to true to make panel in raised style

Table 22 - ESD Gradient Panel Element Properties
Primitives
| ESD Render Functions

A Primitive is a special type of logic node which is a [ —
wrapper for a rendering function called by Render slot. ~ [ Primit

It has no return value and its properties cannot be
output to other logic nodes. Similar to widgets, it
appears on the screen, but is unable to handle user

input.

B ESD Bitmap

B ESD Bitmap Scaled

W ESD Line (Integer)
ESD Line ( d Point)
ESD Rectangle (Integer)

ESD Gradient Rectangle

| |
| |
. ESD Rectangle
| |
| |

adient Rectangle (Inte...
| Display List

Figure 83 - Primitives
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ESD Bitmap

The ESD Bitmap object allows users to display a [EEEg]

bitmap resource. A bitmap resource is generated [ SR

from an image file by adding it into a project. A
bitmap resource is treated as a single bitmap cell B ESD Bitmap Rotated

by default with the name “(Bitmap Resource)_0". B8 ESD Bitmap Scaled

. ESD Line (Integer)

W ESD Line (Fixed Point)

B ESD Rectangle (Integer)

. 50 Rectangle (Fixed Point)

For example, if the bitmap resource is named
“photo.jpg”, the default bitmap resource will be
named as “photo_0". Users can define how many
bitmap cells they want by specifying the
"CellHeight” property.

X

Y
Bitmap Cell

Color

Figure 84 - Bitmap Primitive

Property Name Description

X x coordinate of Bitmap, top-left, in pixels
y Y coordinate of Bitmap, top-left, in pixels
Bitmap Cell Bitmap cell to display

Color Color to be applied to bitmap

Table 23 - ESD Bitmap Properties

To add a bitmap Properties
Property Value

. - . R File P

Click and select “File > Add” or click from the |
. . N ile Name Ducati_side_shadow....

toolbar. A bitmap cell is then assigned. ESD Name Biiae
4.14 supports the following image file formats as input - Category
“.png”, “.jpg” and “.jpeg”. Bitmap resources can contain a 2°""°‘ y ‘:RGTB””

. R . OmMpresse rue
single or multiple cells based on the CellHeight value. CellHeight i

CellNames
If the value of the "CellHeight” is zero, then the number of e
cells is one.

If the value of the "CellHeight” is non-zero, then the
number of cells value is calculated as shown below -

Number of Cell = Bitmap Height / CellHeight

»

Upon adding a Bitmap, the new bitmap resource will be
added into the library under the category - User

ReSOUrCeS”. B Logic Interface
ﬂ User Actors
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ibrary
To use an ESD Bitmap, drag and drop the ESD Bitmap Node L, B ESD Primitives

into the Layout Editor or Logic Node Editor. = ESD Bitmap
B ESD Bitmap Rotated
0 3

Choose a Bitmap Cell to display from the dropdown list. Properties

Property Value
(ESD Bitmap)
MName ESD Bitmap
Active v True
Depth Sort 1.00
; 296
¥
Bitrap Cell

b Color

The list of Bitmap Cell values is updated automatically after a new image file is added
into a project.

a rendering function in ESD 4.14. Users are required to upgrade ESD Bitmap to

i j Use ESD Image to display bitmap as ESD bitmap is non-widget, and used only as
ESD Image from ESD 3.X.

ESD Line

The ESD Line allows users to draw lines on the

ESD Line (Integer)
screen.

Figure 85 - ESD Line

i T Use ESD Widgets - Line Widget to display line as ESD line is non-widget, and

used only as a rendering function in ESD 4.14. Users are required to upgrade
ESD Line to Line Widget.
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Property Name
x0

y0

x1

vyl

Width

Color

Fixed Point Variant

Description

x — coordinate of the start point, in pixels
y — coordinate of the start point, in pixels
x — coordinate of the end point, in pixels
y — coordinate of the end point, in pixels
Line width, in pixel

Line color, in RGBA format

Table 24 - ESD Line Properties

ESD Line (Fixed point) expresses the properties with pixel attribute in fixed point format.
It provides more control to lines.

ESD Rectangle

The ESD Rectangle allows users to draw

rectangle on the screen.

Property Name
X

Y

width

height

radius

Color

Fixed Point Variant

EsD Rectanale (Inteqger)

Figure 86 - ESD Rectangle

Description

x coordinate of Bitmap, top-left, in pixels
Y coordinate of Bitmap, top-left, in pixels
width, in pixels

height, in pixels

radius of the round corner, in pixels
color of the rectangle

Table 25 - ESD Rectangle Properties

ESD Rectangle (Fixed point) expresses the properties with pixel attribute in fixed point
format. It provides more control to rectangles.

Display List

The Display List provides a collection of utilities functions related

to EVE Display List.

Figure 87 - ESD Display List
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ESD Theme

A Theme is a collection of colours which can be used
across the application in order to maintain a consistent
style. The library browser provides the necessary logic
nodes to make most use of the theme function.

ets
nder Functions
® (Hidden)
= Lo gic Flow
8 Logic Interface

Figure 88 - Library Browser - ESD Theme

Built In Themes ‘

ESD provides two Built-in Themes for users to configure the colour scheme of project.
They are: Ft_Esd _Theme_LightBlue theme and Ft_Esd Theme_DarkOrange theme.

Wale

eme_LightBlue. theme

Bl ESD Theme

* B Themes
“# Ft_Esd_Theme_DarkOrange
B Ft Esd Theme LightBlue

Figure 89 - ESD Built-in Themes

Table 26 and Table 27 provides information about the built-in themes property -

Property Name Type Value (RGBA) Description

Name String Theme Ft_Esd_Theme_LightBlue
ClearColor RGBA 235,235,235(255) Clear Color

BackColor RGBA 255,255,255(255) Background Color
TextColor RGBA 0,0,0(255) Text Color
ButtonTextColor RGBA 250,250,250(255) Button Text Color
DefaultColor RGBA 113,113,113(255) Default Color
PrimaryColor RGBA 34,119,199(255) Primary Color

Table 26 - Ft_Esd_Theme_LightBlue Theme
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Property Name Type Value (RGBA) Description

Name String Theme Ft_Esd_Theme_DarkOrange
ClearColor RGBA 33,33,33(255) Clear Color

BackColor RGBA 21,21,21(255) Background Color
TextColor RGBA 255,255,255(255) Text Color

ButtonTextColor RGBA 255,255,255(255) Button Text Color
DefaultColor RGBA 107,107,107(255) Default Color

PrimaryColor RGBA 255,127,63(255) Primary Color

Table 27 - Ft_Esd_Theme_DarkOrange Theme

To create a new theme: File Edit Build Tool
e P B Logic
1. Click and select “File > New -> EJ™ B Actor
Theme". P save B Widget
( M Page
“B Theme

B SourceFiles
B Logic Source Files

New Project

Open Project

§ A L A Property Value
2. A new "“*.theme” file is created within the Project folder. (Linked File Proxy)
Using the Property Editor, users can configure it as per falelrame TR e
Mame Theme

their requirement.

Category

Cleart

3. The newly-created theme will be available across the [

project and may be applied it to other widgets with the (ESD Label Button)

theme property. Name
Active Ft_Esd_Theme_DarkOrang
Theme Ft_Esd_Theme_GetCurren
X
Y
Width
Height 36
Font 27
Text Label Button

Primary v True

Ft_Esd_Theme_LightBlue

myFavoristeTheme

-

vvvvvvvvq.

4. The newly created theme will also be available under User
Resources in the Library Browser. Users can drag and
drop the theme to the logic editor.

ESD Primitives
ESD Theme
ESD Utilities
SD Widgets
vder Functions
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ESD Utilities |

v [ ESD Utilities
trnapCell Getinfo

ESD Utilities contains the collection ESD utilities functions. The

following table provides the list of ESD Utilities and its tmaplnfo

functionality.

ESD Utility
ESD BitmapCell GetInfo

ESD BitmapInfo GetHeight
ESD BitmapInfo GetWidth

Bitmap Persist

Color A+RGB Combine
Clamp Float

Get Delta Ms

Get Font Height

Get EVE Host

Get Milliseconds

ESD Idle Checker
Clamp Int16/UInt16
Clamp Int32/UInt32
Load Bitmap to RAM_G
Load Palette to RAM_G
Pop-up Spinner

Switch Bitmap Cell
ESD Timer

Touch Area

Touch Scroll

Touch Tag

Current Tag

Suppress Current Tags
Touch X/Y

Touch X/Y Delta

p Spinner
tch Bitmap Cell

SD Tirner
Touch Area
Touch Scroll
Touch Tag
Current Tag
Suppress Current Tags
Touch
Touch X Delta
Touch ¥
Touch ¥ Delta
Clamp Ulnt16
Clamp Ulnt32

Description

Retrieves the BitmapCell information with given bitmap reference.
Returns the BitmapCell Height of given bitmap reference.
Retrieves the BitmapCell Width of given bitmap reference.

To persist the given bitmap object

Merge Alpha to RGB, to become RGBA colour

Clamp float value with min and max limits

Get Delta time difference in milliseconds since last frame update
called

Return Font Height

Get EVE Host

Get time in milli-seconds for current frame

Check when to sleep and wake up based on the touch events.
Clamp Int16/UInt16 value with min and max limits

Clamp Int32/UInt32 value with min and max limits

Load Bitmap to RAM_G

Load Palette to RAM_G

Pop-up Spinner when the frame is rendered

Switch Bitmap Cell

ESD Timer Actor

Touch Area Actor

Touch Scroll Actor

Touch Tag Actor

Current Touch Tag

Suppress Current Tags

Touch X/Y coordinate

Touch X/Y Delta

Table 28 - ESD Utilities & Description
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ESD Idle Checker Actor provides an actor to check when the application should go to
sleep mode or wake —
up from sleep mode. ; Switch Page
One of the main use :
cases of the idle
checker actor is to e
check for idling and g Pages
wake up event for - e
displaying the
screen saver page. IilePage
The picture on the o m o e
right demonstrated = ekt =
in "AppScreen.page” !
uses Idle Checker to e
switch between e :
application pages
and the idle page. The idle checker has an interval of 250 ms and count of 60 intervals.
In other words, it may timeout when there is no touch event for 15 secs (60 * 250 =

15000 ms).

Logic Flow

A Logic Flow is an ESD built-in logic node. It is used to define |kl
the logic or control flow and contains the following nodes:

Pointer

Iding

o 5D Layouts
= Condition ESD Render Functions
= Binary Condition — E‘E Eh.?”.m
S0 Utilities
= [ocal Method I
Logic FI
Co

= Binary Operator

= Ternary Operator ndition

% Local Method
Binary Operator
= Sequence Ternary Operator

= Unary Operator

Unary Operator

=  Switch

Sequence

Switch Value
Set Variable
Watch Variables

Switch
Switch Value

Set Vanable

Watch Variables

User Actors

User Functions

Uzer Globals
zer Layouts

User Logic

User Pages

Figure 90 - Logic Flow
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Library
| ESD Layouts
| ESD Render Functions
S0 Theme
SO Litilities

Condition node provides a set
of rules to be performed if a
certain condition is met. In
other words, it allows
applying decision points.

50 Widgets
Lo g 1c Flow
T Condition

"' Binary Condition

Binary Operator
Operator

Unary Operator
Sequence
Switch
Switch Value
Set Variable
Watch Variables

Figure 91 - Logic Flow - Condition Node

Whenever a condition node is called, a "Then” condition will be called when the “If”
expression is True, otherwise an "Else” condition will be called.

Ensure that the input for the “If” connection is a Boolean variable (i.e., True or False).

Binary Condition \

Binary Condition node provides a set [Ecy]

of rules to be performed based on the 0 ESDLayouts -

result of a binary operator on two B EJE :_;:ﬂ:lcr Functions D_u_ -
input values. In other words, it allows — E:ﬁ Ut‘i'l‘irt'i‘; L'f:”ﬂlﬂ
applying decision points. B ESD Widgets Right Value

Binary Operator
Ternary Operator
Unary Operator
Sequence
Switch

Switch Value

Set Variable
Watch Variables

Figure 92 - Logic Flow - Binary Condition Node

Whenever a binary condition node is called, a "Then” condition will be called when the
result of binary operator on left and right value is True, otherwise an "E/se” condition will
be called.

The binary operator is specified by user and it will be evaluated when the node is called
through “Do” input call.
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Local Method

Local Method node is used to add a visual function node. It works as a place holder
where user will provide input using parameters and put the function body in logic editor.
It gives the option to specify the no. of parameters, parameter type and parameter
name to the function as input. User can select the parameter count using scroll bar and
add parameters (type and name) from the properties tab.

| ESD Layouts
| ESD Render Functions
© ESD Theme
ESD Utilities
&l ESD Widgets
Logic Flow
" Condition
Binary Condition
% Local Method
Binary Operator
Ternary Operator
Unary Operator

Sequence
Switch

Switch Value
Set Variable
Watch Variables

Local Method

Properties
Property Value

(Local Method)
Name Local Method
Type int
Buffered False
Parameters

(0]

(0]

(1]

(1]
Function Body if(x>0 && x<=10)

Local Method

Result
Yy

if(x >0 && x<=10)
y=1;

else if{x=>0 && x<=10)
y=2

else if{x>20 && x<=30)
Yy =3

else if(x =30 && x<=40)
y=4

else

y =0;

Figure 93 - Logic Flow - Local Method

e “Parameter Type” - Type of input parameter to be selected from drop down
menu i.e., int, float, char* or Ft_Esd_Theme* etc.
e “Parameter Name” - Name of the variable should be according to ANSI C coding

standard.

e "Result” - Return value from this function which will be assigned to a variable or
input to new widget or assigned to output directly.
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Binary Operator

This node contains Binary Operator REZEq!

that operates on two operands W ESD Layouts — -

(inputs) and manipulates them to 8l ESD Render Functions Left Value Result
B ESD Theme Right Value

return an output. For example:  ESD Theme e

Result=Left Value * Right Value.

[+1 Binary Operator

Unary Operator
Sequence

witch

tch Value
Variable

' Watch Variables

Figure 94 - Logic Flow - Binary Operator Node

The following table provides a list of binary operators supported by ESD 4.14.

Binary Operator

Description
Equal to comparison operator
Not Equal to comparison operator

&& Logical AND operator

& Binary AND operator

| Logical OR operator

| Logical OR operator

* Multiplication operator

/ Division operator

% Modulus operator

~ Binary XOR operator

+ Addition operator

- Subtraction operator

, Comma operator

> Greater than operator

< Less than operator

>= Greater than or equal to
<= Less than or equal to

<< Binary Left Shift Operator
>> Binary Right Shift Operator

Table 29 - Binary Operators Supported by ESD 4.14
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Ternary Operator

This node contains Ternary Operator b ks Ternary Operator
that operates on three arguments. [ EJEL N @ Result
First is the comparison argument; B ror Thare Value If True

! ESD Theme

second is the result upon a true B ESD Utilities e
comparison and the third is the result F
upon a false comparison.

T Condition
Binary Condition
Binary
Ternary Operator
Unary Operator
Sequence
Switch
Switch Value
Set Variable
Watch Variables

For example: Result= condition
? "Value if true”: “Value if false”.

Figure 95 - Logic Flow - Ternary Operator Node

Unary Operator \

. . Library
This node contains Unary Operator that | ['] Unary Operator
operates on a single operand (input). — [ "
For example: ~. B ESD Theme

B ESD Utilities
| ) Widgets

perator
Ternary Operator
Unary Operator

Sequence
Switch

Switch Value
Set Variable
Watch Variables

Figure 96 - Logic Flow - Unary Operator Node

The following table provides a list of unary operators supported by ESD.

Unary Operator Description

! Logic Negation
& Address of

* De-reference

+ Positive operator

- Negative operator

One’s complement

1 Non-zero value converts to 1and other values converts to 0.
Table 30 - Unary Operators Supported by ESD

2
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“Sequence” node allows users REERE

Seqguence
to define a series of calling Bl ESD Layouts
actions. When the “Do” input ¥l ESD Render Functions
call is invoked, the calls will be I ESD Theme
triggered sequentially. The = ESD Utilities Properties

Prope: Value

number of calls is specified by SLiTEE

users in property “Count”. _'f.'g:f_Fr:':j'"i""._n

(Sequence]

MName Sequence
T Binary Condition Count ]
M Binary Operator
M Termary Operator
M Unary Operator

Sequence

Switch

Switch Value
Set Variable
Watch Varniables

Switch Node

“Switch” node will call different “t'rf'f""_

branches based on the input & ESD Layouts

value, like a “Switch-Case” _ ESD Render Functions

statement in C language. Users = ESD Theme

can define any number of & ESD Utilities

branches and the values to be E5D Widgets Properties

compared with input value Logic Flow Property Value
through  “Cases”  property. T Condition (Switch)

Figure 101 shows an example of E’!”ar ndition Nar Switch
3 branches defined and called Binary Operator
respectively if input value is y Uperator

equal to 1 or 2 or 3. Since, the Unary Operator

input value is pre-set to 4; the N SEqUEnGE

default branch is called if no Switch

. . . T LY} -
connection is made on it. W Switch Value
Set Vanable

Watch Vanables

Figure 98 - Logic Flow - Switch Node
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Switch Value

“Switch Value” is a node
to select one output
value from  multiple
predefined values in
“Cases” property based
on input value. The
example in Figure 99
shows 2 “Cases” branch
and property “Cases” 0
defines such logic: The
“Result” value is 4 if
input  value s 1.
Therefore, the result
value is 5 when the
input value is 3.

Library

| ESD Layouts

Properties
Property Yalue
S0 Render Functions
S0 Theme
SO Utilities
50 Widgets
Logic Flow
=T Condition

Binary

(Switch Value)
Mame Switch Value

Comment

=F
i

Type
Walue
* (Cases

[0]
[0]
1]
1]

Default

ondition

Ternary Operator

[N R S S Y

Unary Operator

Ln

Sequence

Switch

[+

]

Switch Value
Set Vanable Switch Value
M Watch Variables

Switch Value

Set Variable

The Set Variable node is used
to set the values of a variable.
It links an event call with a data
binding to a Writer (output a
functional call through “writer”)
or a Variable (sets a variable to

the value).

Library
| ESD Layouts
| ESD Render Functions
S0 Theme
SD Litilities
5D Widgets
Ln:ngic Flow
T Condition

Unary Operator
Sequence

Switch

Switch Value
Set Variable
Watch Variables

Figure 100 - Logic Flow - Set Variable Node
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Watch Variables

Watch Variables
Changed [

The Watch variables node is [kl
used to monitor a set of |
variable updates. A single B ESD Render Functions
watch variable node can — E‘EEE’EL’I‘:
monitor ‘n’ number of | ESDY u.”d;:t,
variables which can be ;
different (primitive) types.
However, the more the input
variables have connected, Y
the more frequent the Ternary Operator
output “Changed” will be Unary Operator
triggered. User can also ~, Jequence
connect input slots: switch

Switch Value
Set Variable
Watch Variables

Figure 101 - Logic Flow - Watch Variable Node

e "Check” - used to trigger an immediate check for the input variables against
previously checked values.

e “Reset” - set base values as current input values, and monitors changes from
there.

This watch variable could be very useful during the debugging, or multiple input trigger
events. It simplifies nested-if conditional flows.

Logic Interface \

A Logic Interface is an ESD built-in logic node. It is used [ReEEEl

to define an interface and contains the following nodes: & ESD Layouts
50 Render Functions

50 Theme

-
- -gtht . ESD Utilities
- S_” pL; | ESD Widgets
igna Logic Flow
= Slot c Interface
» Variable Input
»  Writer Cutput
* Widget Interface Signal
Slot
_ Variable
User Actors
U=zer Functions
User Layouts
User Logic
User F'a_qes.
Figure 102 - Loglc Interface
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The Input node is used to create an input interface for its parent logic node to bind
incoming data. For instance, while creating a widget, an input node will define a property
for the widget whose value depends on the connection. Users can configure its property
through the Property Editor.

Library

| ESD Layouts

| ESD Render Functions| Properties

| ESD Theme Property Value

| ESD Ltilities {Input)

| ESD Widgets Name Input
Ln:ngic Flow

Msplay Name

Logic Interface Comment

& Input Type
Output Edit Role

r Signal Min

* Slot

# Variable Single Step

,,.n"'f, Writer Default
Widget Interface

Maz

Figure 103 - Logic Interface - Input Node

The Output node is used to create an output interface for its parent logic to bind the
outgoing data. For instance, while creating a widget, an output node will define an
interface for the widget to display values to the users. Users can configure its property
through the Property Editor.

Library
b I ESD Layouts
Yl ESD Render Functions Properties
| ESD Themne Property Value
S0 Utilities (Output)
5D Widgets hame Output
Logic Flow Display Mame

Logic Interface

nput
Output
Signal
5 Slot
«" Variable
..n"f. Writer
«" Widget Interface

Figure 104 - Logic Interface - Output Node
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The Signal node is used to create an outgoing event function call. Users can configure its
property through the Property Editor.
Library
B ESD Layouts
| ESD Render Functions
50 Theme
5D Utilities .
| ESD Widgets Properties
Logic Flow Value
c Interface
Input Mame Signal
Cutput
Signal
Slot
Variable
\ Writer
Widget Interface

L]
=]

Display Name

Figure 105 - Logic Interface - Signal Node

The Slot node is used to create an incoming event function call.

Library
» B ESD Layouts
[ ESD Render Functions
eme

ES

slot
Signaled []

¥ Signal
k Slot

.4' Widget Interface

Figure 106 - Logic Interface - Slot Node

Built-in Slot

There are a number of built-in slots available for Widgets, Pages and Applications which

are automatically called through the node hierarchy. The following table provides the list
of built-in slots.

Built-in Slot Description

Start Called when the node is created in memory

Render Writing rendering calls to the co-processor command buffer. It is
repeatedly called.

Update Called once before the frame render. It is called frequently.

Idle Called repeatedly while waiting for the frame to flip

End Called when the node is removed from the memory

Table 31 - Built-in Slots
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The following pseudo-code may help you understand how these slots are invoked:

//Bpplication is booting up and started
Start ()
//Now UI 1is launched
while (UI is running)
{

Update () ;

Render () ;

Idle () ;
}
//Bpplication is ending
End ()

Variable

The Variable node is used to define a plain C variable. Users can drag and drop the
Variable from the Library browser to the logic node editor and configure its property
through the Property Editor.

Library
| ESD Layouts
| ESD Render Functions
S0 Theme

Variable

Value

Properties

SD Utilities
SD Widgets Property Value

Logic Flow (Variable)
EEQiC Interface Mame Variable
& Input
Output
C St Type
Varniable Edit Role
. Writer Min
Widget Interface Max
Single Step Accessible from outside
Value the node with no write
Private

Display Mame

Comment

Accessible from outside
the node

Only accessible from its

owner (Default)
Property Editor

Figure 107 - Logic Interface - Variable Node
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Library
| ESD Layouts
| ESD Render Functions
| ESD Theme
| ESD Utilities
| ESD Widgets
Logic Flow
Logic Interface
“1 Input
Output
Signal
Slot
Varnable

The Writer node is used to define a value writing interface
for its parent node. Generally, it is used to setup the value
for the external variable. For instance, while creating the
ESD Spinbox widget, the “Changed” writer is defined to
update the connected external variables of Spinbox widget
once Spinbox value is changed.

. Writer
Widget Interface

Widget Interface

The Widget Interface node |8 Widoet Interface

shows the interface of base
widget interface. Since ESD
4.0, all layouts, pages and

5D Layouts
5D Render Functions
50 Theme
SO Utilities

Pointer
Container
Active

widgets have been e Local X
. . sh l.'l'll:lg!:tE-
implemented from this Logic Flo Local ¥

) - ogic Flow »
widget interface. For oaic Interface Local Width
advanced users, this g Local Height

Input
Cutput
Signal

Slot

widget interface node could Local Rect
be useful for designing user
customized widget in order
to use its base interface for
accessing information from

ESD widget framework.

Global ¥
Global ¥
Global Width
Global Height
Global Rect

Wanable
Writer

Widget Interface

Figure 109 - Widget Interface

Property Name Description

Pointer Provides the pointer of this widget, allow other widget/layout/page to refer

Container Provides the pointer of this widget’s immediate container. Normally, a
widget’s immediate container is a layout

Active Set and get the current widget active

Local X Set and get the current widget local X. Local X refers to the local x-coordinate
with reference to its container

Local Y Set and get the current widget local Y. Local Y refers to the local y-coordinate
with reference to its container

Local Width Set and get the current widget local width. Local width refers to the designed
width with reference to its container

Local Height Set and get the current widget local height. Local height refers to the
designed height with reference to its container

Local Rect Set and get the current widget local dimension with reference to its container

Global X Set and get the current widget global X. Global X refers to the global x-
coordinate with reference to screen

Global Y Set and get the current widget global Y. Global Y refers to the global y-

coordinate with reference to screen
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Global Width Set and get the current widget global width. Global width refers to the
designed width with reference to screen

Global Height Set and get the current widget global height. Global height refers to the
designed height with reference to screen

Global Rect Set and get the current widget global dimension with reference to its screen

Table 32 - Widget Interface Properties

« " ~# Advanced users are encouraged to refer the example project “WindowlLayout”
for details.

e All Local properties are subjected to difference from the respective Global
properties. As the global values are determined by the layers of the layouts
as containers.

e Global properties are the values determined at the runtime. While Local
properties are values determined at design time.

e Global properties are eventually stable in runtime, as layers of layouts may
require multiple rendering cycle to stabilize.
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Property Editor \

The Property Editor provides user a unified interface to ks

edit properties. Each logic node in ESD, including a [kEel Value
widget, has its own predefined properties. Users can edit Slimde by

the property values using the Property Editor to customize Name ESD Radio Button
logic nodes.

Depth Sort 0.00

Active ¥ True

. . Theme Ft_Esd_Theme_GetC...
The sample picture given below shows an example of the e o

ESD widget “ESD Radio Button”. - 0
Width 20
Height 20
Font 27
Text Opticn

Figure 110 - Property Editor

Common Properties \

While each widget has its own properties defined for its own specific features, the
following are some of the properties that are commonly found in all the widgets of ESD
application -

= Name
= Depth Sort
= Active

Properties

Property Value

Value
(ESD Radig Button)

MName ESD Radic Button
Depth Sort 0

Active

Theme Ft_Esd_Theme_Get(..
X 0

¥ 0

Width 20

Height 20

Font 27

Text Option

Figure 111 - ESD Common Properties

ESD Slider
0.00
v v True
Theme Ft_Esd_Theme_GetC...
X 10
Y 10
Width 160
Height 2

Alpha

WValue

Range
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Each node must have one unique name as an identifier.

Users are required to define a name that is valid C Value
identifier, since these names will be used by ESD for :
generating the source code. ESD Slider

Depth 0.00

Active v True

Theme Ft_Esd_Theme_Get(C...
X

"

Width

Height

Alpha

Value

Range

Figure 112 - Name Property

Depth Sort

Each widget and page have one common property
called Depth Sort. It is of floating-point type, and

Value

} Slider)

defines the sequence of rendering. The default value Name ESD Slider
is “0.00” and users may change it accordingly to 0.00
adjust the sequence of the rendering process. Acti v True

Theme Ft_Esd_Theme_GetC...
X

v

Width

Height

Alpha

Value

Range

Figure 113 - Depth Sort Property
|
The context menu helps users adjust the rendering
sequence without dealing with the values and can be
accessed within the layout editor by selecting the -
widget or page and right-clicking it. Bring to Front

Bring Forward

S5end Backward

5end to Back

Figure 114 - Right Click Menu

The widget or page with the greatest positive "Depth Sort” value will be rendered last
and appear on the topmost layer.
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Active

Each widget has one Active property of Boolean type [REEEE

which controls whether or not it is rendered on the QL] Value
screen. Active property in false state does not mean that e

the widget is released from the memory. Instead, it [ ESD Slider
means that the widget is not rendered on the screen, but 00

= e
still is part of the memory. o Eod Theme Getc
- Esd_Theme GetC...

Width
Height

Alpha

Value

Range

Figure 115 - Active Property

« © ¥ Users must ensure that the Name property follows the standard C identifier
syntax in order to make the generated source code more readable.

Programming Features

This section explains about the programming features. ESD enables users to write C
code and make this code available in the form of logic nodes so that the code can be re-
used across multiple projects.

Macros

In order to provide the development environment with necessary information about the
available functionality in a user’s code, ESD provides a set of macros. These macros are
necessary and useful when users add their own code that needs to be used from the
logic node editor or layout editor.

These macros are generally used together with the source code. It is recommended that
the user defines all the definitions associated with macros immediately following the
macros declarations where ever needed and in the same file. Not doing so, may result in
unexpected behaviour. For e.g., ESD _FUNCTION macro immediately needs to be
followed with function definition. Comments are acceptable between the macro and the
definitions.

ESD_TYPE

ESD_TYPE provides information about a primitive type. All types are assumed to have a
default value of 0.

Syntax Example:

ESD_TYPE(ft_uint32_t, Native = UInt32, Edit = Int)
ESD TYPE (char *, Native = Latinl, Edit = String)
ESD TYPE (Esd BitmapCell *, Native = Pointer, Edit = Library)
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Parameter Type Parameters

Description

Native Type used internally for formatting C literals and
binary representations
Void Not a type (default)
Int64, Int32, Int16, Int | Signed integer
8,IntPtr
UInt64, UInt32, UIntl6, @ Unsigned integer
UInt8, UIntPtr
Double 64bit floating point
Float 32bit floating point
Char An 8bit text character
Bool C99 Bool
Utf8 String with UTF-8 encoding
Latinl String with Latin 1 (ISO8859-1) encoding
Pointer Pointer type
Struct Struct type (not fully supported yet)

Edit Used by the Properties Editor to specify the control
to edit the value and by code generation when
using the fixed-point formats

None No editor control (default)

Int Integer, spin-box integer control

Real Floating point, spin-box floating point control
Boolean One or zero, checkbox

String Text, single-line entry

Fixed1, Fixed2, Fixed point, spin-box floating point control

..., Fixed32

ColorARGB Color, rgb with alpha

ColorRGB Color, rgb without alpha

Library Select a function specified with ESD_FUNCTION to

provide the value (useful for pointer values)

Table 33 - Macros - ESD_TYPE - Parameters

ESD_ENUM

Enumeration types are usable as types from the logic editor. It will use the specified
Type in the generated code. Internally, only the enumeration identifiers are parsed;
values are ignored. Enumerations used in the properties are serialized as their identifier
string. Enumerations are edited using a drop-down control in the Properties Editor.

Syntax Example:

Using pre-processor definitions, the symbol right after each #define statement is used.

ESD ENUM(Ft BitmapFormat, Type = ft uint32 t)
#define PALETTED 8UL
#define PALETTED4444 15UL
#define PALETTEDS565 14UL
#define PALETTEDS 16UL

ESD_END ()

Parsing from an enum requires the identifiers to be on separate lines, the first identifier
of each line is used.
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ESD ENUM(Ft BitmapFormat)

enum Ft BitmapFormat

{
PALETTED,
PALETTED565,
PALETTEDS

bi

ESD_END ()

In case the enumeration is defined in another file, a macro is available to manually
specify the identifiers.

ESD ENUM(Ft BitmapFormat, Type = ft uint32 t)
ESD IDENTIFIER (PALETTED)

ESD IDENTIFIER (PALETTEDS565)

ESD_END ()

When the Flag value is specified, the enumeration can combine multiple values, and will
show as a series of check-boxes in the Properties Editor instead of a drop-down menu.

ESD ENUM (Ft CoPro Opt, Type = ft uintlé6 t, Flags)

#define OPT CENTERX 5120L B

ESD END()

To allow users to select 0 as a valid value, the Zero flag can be set. This flag has no
effect when the Flag value is specified.

ESD_PARAMETER

ESD_PARAMETER is a macro designed for the registration of user-defined parameters
within ESD. Whenever a user creates an ESD_FUNCTION or ESD_METHOD, they can
establish the parameter by utilizing ESD_PARAMETER.

Syntax Example:
ESD PARAMETER (value, Type = Int)

ESD PARAMETER (test, Type = ft bool t)
ESD PARAMETER (color, Type = ft argb32 t)

ESD_FUNCTION |

ESD_FUNCTION is a macro to register a user defined function

to ESD, so that the application can add that function into the : E:g 'Ea_'-'"":'j'{tﬂ'F -
User Functions category node which is located in the Library ' oD T:;:; unctions
browser. ESD_FUNCTION is not applicable for static functions | ESD Utilities
even though ESD permits to make any function with B ESD Widgets

ESD_FUNCTION macro. Ll:lgic Flow

i Logic Interface

Figure 116 - User Functions Example
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Syntax Example:
The following syntax example is to register a function called "hsvToRgb” to ESD.

ESD FUNCTION (hsvToRgb, Type = ft argb32 t )

ESD PARAMETER (h, Type = double)

ESD PARAMETER (s, Type = double)

ESD PARAMETER (v, Type = double)

ft argb32 t hsvToRgb (double h, double s, double v)

Upon registering the function, it is added to the User Functions category.

Parameters Description
Type The function’s return value type
Table 34 - Macros - ESD_FUNCTION - Parameters

e FEach ESD_PARAMETER defines only one function parameter. It must
be kept in a single line for each parameter.

o “Buffered” flag can be attached after toggleLED
“Type”. It will create the output of the
NOTE function stored in a member variable,
whenever the function is called.
Without the Buffered flag, you'll have a
function with just one output value which is called whenever the
output value is used. Here is an example:

ESD FUNCTION (toggleLED, Type=int,Buffered)
ESD PARAMETER (state, Type=ft bool t)

ESD_METHOD

ESD METHOD works similar to ESD_FUNCTION with an enhanced feature. It takes a
logic/actor/widget/page/app context pointer as first parameter. It can be used only
within the logic editor of that logic/actor/widget/page/app.

Syntax Example:

The following syntax example defines one method to handle “Pushed” event for an ESD
Push Button widget contained in “MainPage.page”.

ESD METHOD (MainPage ESD Push Button Pushed, Context = MainPage)
void MainPage ESD Push Button Pushed(MainPage *context)
{
//
}
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The logic node connection and the corresponding output is shown in the sample picture
below -

Library
ESD Push Button
Auctive
Down [
up [ ESD Push Button Pushed

Pushed E—-———-___E‘ call O

RLE

¥
Width
Height
Font
Text
Primary

Pushing

Figure 117 - ESD_METHOD Example

Parameters Description
Context Pointing to the caller’s context
Table 35 - Meta Macros - ESD_METHOD - Parameters

e Additional parameters can be defined similar to ESD_FUNCTION. But

these parameters must be added only after the Context parameter.
Here is an example:

NOTE

ve O £SD Push Button Pushed
Pushed [B———& Cal

tent

ESD METHOD (MainPage ESD Push Button Pushed, Context =
MainPage)
ESD PARAMETER (test,Type = ft bool t)
void MainPage ESD Push Button Pushed(MainPage
*context, ft bool t test)
{

//
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e If the return value of method function is to be defined, “Buffered”
keyword needs to be added after the “Type” definition. Refer to the
syntax example -

ESD METHOD (MainPage ESD Push Button Pushed, Context =
NOTE MainPage, Type=int,Buffered)

ESD PARAMETER (test,Type = ft bool t)

int MainPage ESD Push Button Pushed(MainPage

*context, ft bool t test)

{

!/
}

ESD_VARIABLE

ESD_VARIABLE is a built-in macro used to define a local variable of a logic node.
Syntax Example:

ESD VARIABLE (Margin, Type = ft intl6 t, Default = 0, Public)
ft intl6 _t Margin;

ESD_GLOBAL

ESD_GLOBAL is a built-in macro used to define a global variable accessed across
different pages of a logic node. Global variable declaration should present in the header
file and definition should be in source file.

Syntax Example:

In header file:
ESD GLOBAL (Var, Type = int) // type must be specified
Extern int Var;

In C file:
Int Var = OxFFFF; // Assign initial value

ESD_INPUT

ESD_INPUT is a built-in macro used to define an input variable of a logic node.
Syntax Example:

ESD INPUT (Margin, Type = int)
int (* Margin) (void *context) ;

ESD_OUTPUT

ESD _OUTPUT is a built-in macro used to define an output variable of a logic node.

Syntax Example:

ESD OUTPUT (FirstPos, Type = int)
int LayoutSplit FirstPos(LayoutSplit *context);
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ESD_UPDATE

ESD UPDATE macro is used to register a function that is called repeatedly by built-in
“Update” slot. This function shall not have any return value.

Syntax Example:
ESD UPDATE (Ft Esd BitmapPersist)

ESD PARAMETER (bitmapCell, Type = Ft Esd BitmapCell *)
void Ft Esd BitmapPersist (Ft Esd BitmapCell *bitmapCell);

Parameters:

Users can define their own parameter used by the registered function by using the
ESD_PARAMETER.

Pre-compiler options

Within the ESD C code simulation engine, the following macros are predefined in
generated source code:
e ESD SIMULATION

ESD_SIMULATION

ESD_SIMULATION macro is defined when the code is running through the ESD
simulation engine. If some part of the user’s C source code is not supposed to be run
under the ESD simulation engine, for example, accessing some hardware specific
registers, users may choose to skip the code by using this macro.

Add User Functions

Users can define their own functions by writing the C source code directly. If these
functions are defined by using the predefined “ESD_FUNCTION”, they will be shown
under the “User Functions” category in the library browser. Users can drag and drop
these nodes into the logic node editor to use them.

Creating Source File ‘

To add user functions, users need to create a C
source file by clicking File > New - Source
Files. | B Widget

& | Page

“& Theme

B Source Files

B Logic Source Files

Product Page 122
Document Feedback Copyright © Bridgetek Pte Ltd



http://brtchip.com/eve/
mailto:docufeedback@brtchip.com?subject=BRT_AN_029%20Version%201.7

)

\/
w‘ Bridgetek BRT_AN_029 EVE Screen Designer 4.18 User Guide
*

. .
A BRIDGING TECHNOLOGY Version 1.7

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Upon adding the source file, include the following header (mandatory) in the source
file.

#include "Ft Esd.h"

Editing the Source File

To make ESD responsive of the user functions, the ESD specific macro "ESD_FUNCTION
or ESD METHOD” needs to be added before the function definition. Refer to the
examples given below -

Syntax Example:

=  Without parameter input and return value
ESD FUNCTION (BulbPage TestFunc)
void BulbPage TestFunc() {}

BulbPage_TestFunc

O call

= Without parameter input, but with the return value

ESD FUNCTION(Ft Esd Theme GetCurrent, Type = Ft Esd Theme *)
Ft Esd Theme *Ft Esd Theme GetCurrent () ;

Current Theme

= Without return value defined, but with the parameter input
ESD FUNCTION (Ft Esd Theme GetButtonTextColor, Type = ft rgb32 t)

ESD PARAMETER (theme, Type = Ft Esd Theme ¥*)
ft rgb32 t Ft Esd Theme GetButtonTextColor (Ft Esd Theme *theme) { //.. }

pu_CoCmd_FgColor

= Without return value and parameter input

ESD FUNCTION (Ft Esd Theme GetButtonTextColor, Type = ft rgb32 t)
ESD PARAMETER (theme, Type = Ft Esd Theme ¥*)
ft rgb32 t Ft Esd Theme GetButtonTextColor (Ft Esd Theme *theme)
{

e
}

Get Button Text Color

theme
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